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Starting with ProArt/ProLace

This chapter contains information about the installation and the basic concepts of the 
ProArt/ProLace programs

Introduction

ProArt/ProLace provides an ideal aid for the embroidery designer and/or puncher. It 
helps you to create technical embroidery designs. With ProLace you can also punch 
directly on the designs.

 



Installation

System requirements

The system requirements are as follows:

●     Pentium IV based Windows2000 or WindowsXP computer 

●     minimum 512MB RAM

●     10GB free hard-disk space

●     CD-ROM drive

●     graphic screen with a minimum resolution of 1024x686 dots

●     Mouse or WinTab digitizer as input device

●     plotter or printer

●     Scanner

The program is delivered on CD-ROM.

How to install ProArt / ProLace

●     Insert the ProArt/ProLace CD and run the SETUP program. The setup program 
will guide you through the installation steps. After the installation you will get a 
start button on your desktop.

●     Plug the the Rainbow Sentinel SuperPro lock on the printer port. The lock is 
included in the ProArt/ProLace package.

●     Install the SuperPro driver before you start ProArt/ProLace. (See following 
section)

●     Next you can change the user information, which appears in the header of each 
design. Therefore open the file C:\Icad\User.ini with the Notepad and modify 
the entries (e.g.  AMD_USER=AllCAD Technologies Ltd.).
Example:
amd_enlarger = Loi Sakaeo
amd_puncher = Günter Heinzle
amd_user = Embroidery Connection Co. Ltd.
amd_user2 = 442/93 M.5, T.Naklua, Chonburi 20150
amd_user3 = email: office@embroideryconnection.net
amd_copyr = Embroidery Connection Co. Ltd.

●     Now you can start ProArt/ProLace. If you install ProArt/ProLace for the first 
time a dialog-box opens where you must enter the user data and the 
ProArt/ProLace Serial Number. You can find the serial number on the CD.

How to install the Rainbow Sentinel SuperPro lock for 
Windows2000® or WindowsXP®



Before you can start the software on a Windows2000® or WindowsXP® system, you 
must install the driver for the Rainbow Sentinel SuperPro lock.

●     You can find the driver in the directory  \Tools\Ntlock of the ProArt/ProLace 
CD.

●     Run the command setupx86.exe to start the installation program.

●     Call up Functions / Install Sentinel Driver.

●     After having installed the driver you must restart the system.

Note: To be capable to install the Sentinel driver, you must 
have Administrator rights!



Directory structure and file description

In this section the directory structure of ProArt/ProLace is described.

ProArt/ProLace directory structure

The base directory for all ProArt/ProLace sub-directories is the program directory 
ICAD. The BIB subdirectory contains the symbols and definition tables.
C:\ICAD Program directory
    \MNU Menus and Bitmaps for the toolbars
    \BIB
        \DATA        Data files
        \S           System block library
        \SLD         System and user slides
        \U           User blocks library
        BIB.DIR      Identification files
        DATA.DIR
        STD.DIR
    \MNU             ProArt/ProLace menu and bitmaps
    \FONTS           Text styles
    \PATTERNS        Filling patterns

Configuration files in the program directory ICAD

File Description
CMDLINE  CSV
DIALOGS  CSV
MESSAGES CSV
EDS      INI
ICAD     INI
USER     INI
DEFAULT  INI

Context menu prompts
Dialog-box prompts
Other system messages
Definition file for system 
variables
Definition file for system 
variables
User information
Definition of default values

The DATA-directory

File Description
BORPROG  CSV
FRWPROG  CSV
SYMLIB   CSV

Bore program definition file
CRC program definition file
Symbol library contents

Symbol library
The system library is filed in the subdirectory S of the library path. All symbols 



start with the characters AMD and have the extension DWG (e.g. AMDCIR.DWG).

The user library is filed in the subdirectory U, the system slide libraries and the 
user slides are filed in subdirectory SLD.

Attention: User-blocks must not start with AMD!

 



Files and file types 

To memorize/save a  file on a floppy-disk or hard disk it must be given a filename. A 
filename name consists of the name and the extension, which are separated by a full 
stop, e.g. EDS.DLL or COMPLEX.SHX.
ProArt/ProLace uses for system and user files several file extensions, which define 
the type of file. Below you can find a list of ProArt/ProLace file extension in 
alphabetical order:

File Description

.BAK 

.CFG

.DWG 

.DLL

.LIN

.LSP 

.MNU 

.PAT 

.SHX 

.SV$ 

.SLD 

.SLB 

.INI 

.CSV

Safety copy of a design

Configuration file 

Drawing file 

Program files 

Line type definitions 

Lisp program files

Menu files 

Fill pattern definitions 

Character set file 

Periodically saved drawing file

Slide file 

Slide library 

Initialization files

Data tables

 



Data integrity concept 

When you start a new design a file with the chosen name is being created in the file 
extension .DWG, i.e. 91356.DWG.
If you edit this design a copy of the design under the same file name, however, with 
the file extension .BAK will be filed prior to starting the design editor.

During the work process the design data is memorized on a regular basis on the 
hard disk. The time interval, defined with the File/Options... command, can be 
determined in the configuration.

Should the design file name.DWG have been erased for any reason you may search 
first for the file i.e. name.SV$ and rename it to name.DWG. Should this file also 
not be available you can rename the file name.BAK to name.DWG and start work 
with this old version.

In order to save space on the hard disk you should periodically clean the BAK files 
from the hard disk.



How to start ProArt/ProLace

How to start with a new design

The design system is being started with a double-clicking onto start-button on the 
Windows Desktop.
The system is ready when the following information appears on the command 
prompt area of the screen:

AllCAD Technologies Ltd., ProArt 2.0, Build 2004-01-01
Command: 

Now specify a name for the design. Therefore call up the command
File / Save as....

Next call up the command  SETUP. A dialog-box opens where you can specify the 
repeat, the height of the design, the standard stitch density, the yarn etc. After 
leaving the dialog-box, the basic design with the header, repeat and the repeat grid 
is being constructed on the screen.

How to start with an existing design

The design system is being started with a double-clicking onto start-button on the 
Windows Desktop.
The system is ready when the following information appears on the command 
prompt area of the screen:

AllCAD Technologies Ltd., ProArt 2.0, Build 2004-01-01
Command: 

Now call up the command File / Open... and choose the file, which you want to 
edit. The selected file is being loaded and you can continue designing.



The ProArt/ProLace screen 

When working in the design editor, hence when you are working on a  new design or 
editing one, the video areas will be defined as follows:

 Name Description

A Command 
prompt area 

consisting of three lines

B Status line on the  button of the screen

C Pull down 
menu

on the topside of the screen

D Toolbars user definable position. Normally below the 
pull down menu

E Context menu appears on right click

F Graphics area in the center

●     On the command prompt area the last three lines of the command dialog will 
be displayed. It can be switched on and off with the F3-key.



●     The status line shows the actual layer, the active design helps and the 
coordinate of the crosshair cursor.

●     The pull down menu serves as command input. If you click on of the pull-down 
menu items the corresponding menu will be scrolled down and you then can 
select the desired command.

●     The Toolbars serve as command input. To execute a command move the 
crosshair onto the corresponding button and click with the pick button of the 
mouse.

●     The context menu appears on right click with the mouse and it offers normally 
command options.

●     In the center of the screen (graphics area) the actual part of the design is being 
displayed. All changes are immediately shown. A crosshair cursor, controlled by 
the mouse, shows the position of the input.



Design entities 

A large part of designing work consists of placing entities in the design. Entities are 
predefined design elements which can be placed in the design with the relevant 
command. 

The system makes available the following entities:

Object 
type Description

Line 

Circle

Point

Polyline

Text

Block

A line is defined by two points 

To construct a circle there are different 
methods available. 

A point defines a coordinate and is displayed 
as a small circle.

A polyline is a string of lines composed of 
straight lines or arcs. Special forms of 
polylines are ellipses and regular polygons.
A polyline will always be considered as one 
element.

Text can appear in various forms, various 
sizes and directions.

Blocks are entities composed of other 
random elements.



What are layers

Different parts of a design can be allocated to different layers.
A layer is similar to a  transparent sheet of foil. Each singular foil contains certain 
design elements. Different foils put on top of each other result in the complete 
design. This technique allows to make visible or not visible certain parts of the 
design, such as the header.
Each layer has its color. Therefore if the layer is being  changed the actual color will 
change and the relevant elements belonging to each layer can easily be checked.

Layers are predefined in the system and are distinguished as follows:

●     User layers used by the designer to draft and construct the design, and

●     System layers used by the design system by itself for automatic embroidery 
functions.

Attention: You may define your own layers. However, existing 
layers may not be canceled or given a new name because a lot 
of functions depend on these layers.

 
 
 



Colors 

The system offers 255 colors. The colors are numbered from 1 to 255. The first 8 
colors have standard names. 



How to call up commands

A Command can be entered as follows:

●     using the keyboard

●     using the pull down menu

●     using the toolbars

●     using the button menu (on the digitizer mouse)

●     using the digitizer menu

Command input via the keyboard
Write the desired command and press <Return>.

Some commands are defined on the function keys of the keyboard.

F1 - Request Help

F2 - Change over from text to graphic screen

F3 - On/Off of command prompt area

F4 - Change direction of polyline

F5 - Snap nearest

F6 - Snap endpoint

F7 - Snap center

F8 - Ortho mode On/Off

F9 - Snap intersection

F10 - Snap mid point

F11 - Snap perpendicular

F12 - Snap tangent

Command input via the pull down menu
If you move the crosshair cursor into the area of the status line on the top area of 
the screen, different menu lines with a variety of menu titles are shown. If you move 
the cross hair cursor on to a menu title within the menu line, the corresponding 
name will be illuminated. If you press the pick button on the mouse while a menu 
title is illuminated, the menu will be pulled down below.
Now you can choose within the pull down menu and the corresponding function 
which is illuminated can be selected by pressing the pick button of the mouse.

Command input via the toolbar buttons
If you move the crosshair cursor on a button of the screen menu, a short description 
of the function is displayed. To activate the function, press the pick button on the 
mouse.



Command input via tablet menu
If a digitizer is connected with the system, the commands can be chosen from the 
tablet menu. A tablet menu is a printed template occupying a defined area of the 
digitizer. To select a command, place the crosshair cursor on the desired command 
on the menu area and press the pick button.

Dialog-box
The setting of various parameters can be carried out in so-called dialog-box. The 
dialog-box show status, value or name of a size and can be changed by picking the 
relevant area.

Each dialog-box has a field called “OK” which serves to carry out the correction and 
an area named “Cancel” which will end the dialog without changes.



Units and scale

This design system uses millimeter as measuring unit. The scale is 1:1. This means 
all measurements must be indicated in the original size of the embroidery.



How to input data 

Most commands need additional parameters, such as points, angles and distances

Input of angles
The input of angles is effected as follows:

●     Zero degrees is towards east

●     and the angles are defined anti-clockwise.

 
Input of angles using the keyboard 

If the system asks for an angle the input can be carried out using the keyboard.
Command: INSERT
Block name (or ?): *blume1
Insertion point: 100,50
Scale factor <1>: <Ret>
Rotation angle <0>: 45

Angle input using two points 

In most cases angles can be defined with two points. The system in this case 
calculates the defined angle and shows the calculated value.

Displacements
Commands such as MOVE, COPY etc. are defined with displacement distances.

Using the keyboard 

The displacement can be defined with a pair of coordinates, whereby x and y values 



correspond to displacement of the x and y direction. If the system asks for a second 
point after input of this coordinate pair simply press <Return>.

Command: MOVE
Select entities: select
Basepoint of displacement: 10,0
Second point of displacement: <Ret> 

Angle definition with two points 

Displacement can also be defined with two points. The system thereby calculates the 
shown x and y distance and uses the corresponding result.

Point input using the keyboard
In order to localize a defined point in a drawing the CAD programs underlay an 
absolute Cartesian coordinate to the design. A pair of coordinate consisting of an x 
and y coordinate defines the position of each point in a design. The position is 
always being calculated from the origin of the coordinate system (0,0) which is the 
lower left-hand corner of the design.

Whenever you want to give the exact value of a coordinate point you may use the 
command input via the keyboard. Several possibilities are available.

Input with absolute Cartesian coordinates.

A point will be defined by the distance in x and y direction starting from the origin of 
the coordinate system.

Command: LINE
From point: 4.2,-3.1
To point: 4.2,-10 

Input in relative Cartesian coordinates.

A point will be defined using the distance of the x and y direction in relation to the 
last point. These two values are characterized with a @.



Command: LINE
From point: 4.2,-3.1
To point: @0,-6.9 

Input using relative polar coordinates.

A point is being defined with the distance and the angle from the last point. An @ 
 character must be put in front of the command. Distance and angle are divided with 
the < character.

Command: LINE 
From point: 4.2,-3.1
To point: @6.9<45 

Using the point to point method
The input of coordinates of point can also be carried out by positioning the crosshair 
cursor with the mouse. To make a positioning easier several design helps are at your 
disposal.

●     coordinate display in the status line

●     visible dot grid (dot grid with definable distances)

●     invisible snap grid (the crosshair cursor only locks with defined snap points)

●     orthogonal designing



How to work with object snap 

The object snap (to localize a geometrical reference point) can be used when 
designing lines, editing or inserting blocks etc. This feature allows to snap points on 
geometrically defined points of already existing entities. For example if you want to 
pull a line right up to an arc or if you want to draw a line through the center of the 
circles, the object snap makes work a lot easier. 

The object snap can be recalled from the Snap Toolbar or by activating the middle 
mouse button. After defining the object snap method the center of the cross hair 
cursor will be changed to a square. This square defines the search area used to 
search for a point on the object. 

 

The following object snap methods are at your disposal...

Icon Key Description

 NEAr F5 Snaps the point on a line, a circle or a 
polyline, which is nearest to the crosshair 
cursor.

 ENDpoint F6 Snaps the next end point of a  line, a 
polyline.

 CENter F7 Snaps the center of a circle, an arc or a 
polyarc. The object snap square must be 
placed on a visible part of the circle.



 INTersect or
PLAnview

F9 Snaps the intersection point of lines, circles, 
arcs or polylines. Arcs and circles, belonging 
to blocks, are not recognized.

 MIDpoint F10 Snaps the middle of a line or a polyline 
segment.

 PERpend F11 Snaps a point on a line, a circle, or a 
polyline, which is perpendicularly to the last 
defined point.

 TANgent F12 Snaps the point on a circle, an arc or a 
polyarc, which forms a tangent with the last 
defined point.

 QUAdrant  Snaps the nearest quadrant of a circle or a 
polyarc.

 INSert  Snaps the insertion point of texts or blocks.

 NODe  Snaps a point.

 



How to select entities 

With most editing- as well as with some design- and block commands, design 
elements must be chosen for manipulation. Selected entities are highlighted by the 
system. With the following dialog the system asks you to select entities, which must 
be erased:

Command: ERASE
Select entities:

The crosshair cursor is being replaced by the pick-box, which can also be positioned 
with the mouse. From the upcoming menu you may choose the desired entity 
selection method.

Following possibilities of entity selection are at your disposal:

Mode Description

Point input The entity within the pick box is joining the 
selection set.

Select all All entitys in the drawing are selected.

Add to set With Add you can switch back from the remove 
mode to the add mode. Selected elements will 
then be added to the selection.

Subtract from 
set

If Subtract from set is used, newly selected 
elements are erased from the selection.

Last entity Defines the last designed entity for the selection 
set.

Previous 
selection

The same selection set as with the previous 
entity selection is being taken up again.

Window-Inside
Window-
Polygon
Window-Circle

Define a rectangle (Inside), a Polygon  or a 
Circle and all entities, fully placed within the 
area, are selected. 



Crossing-
Window
Crossing-
Polygon
Crossing-Circle

Same technique as Window, however all entities 
either fully or partially within the area are 
selected. 

Outside-
Window
Outside-
Polygon
Outside-Circle

Same technique as Window, however all entities 
fully outside the area are selected.

Fence With this option you define a cutting line. All 
elements touched by it are selected.

Undo The last joint element is being erased from the 
selection set.

 

Note: If you pick an empty area with the pick box, a window is 
automatically created. If you pull the window to the right , the 
selection method window is activated if you pull it to your left, 
the selection method crossing is being activated.

If no further entity has to be added to the selection set, press <Return> or the 
space key. The selected action will then be carried out with the selected elements.
If you want to cancel the entity selection or the active command, press ESC. 

Command: ERASE
Select entities: W
First corner: point 1
Other corner: point 2
Select entities: <Ret> 

 



Files, Plot, Scan, Display

This chapter describes functions to handle a design. All these functions are located in 
the Toolbar Standard or in the pull down menus File and Display.

The Standard Toolbar contains the following commands...
 

  Standard Toolbar 

 NEW - Create a new design 

 OPEN - Open existing design 

 QSAVE - Save a design to disk 

 DRAWORDER - Change the draw order of image 

 SETUP - Initialize a design 

 FORMATS - Select paper format 

 PLOT - Plot/Print a design 

  Cut to clipboard 

  Copy to clipboard 

  Past from clipboard 

 UNDO - Undo a command 

 REDO - Recover the previously undone command 

 Flyout Redraw 

 PAN - Move the display 

 Change display 

   

   

   

   

  Redraw 

 REDRAW - Clean the screen 

 REGEN - Regenerate the screen 

Other commands in the pull down menu



The following commands cannot be selected from a toolbar. They must be called up 
from the pull down menu.

 END - How to terminate ProArt/ProLace session

 SAVEAS - How to save design under another name

See also...

 How to initialize a new design

 ESC - How to interrupt command with ESC key



NEW - How to create a new design 

Toolbar: Standard > New 

Menu: File > New 

Keyboard:  NEW

With the command New a new design is started. The design actually on the screen 
will be terminated, whereby the system will ask, whether you want to save the 
modifications or not.
Thereafter you have to give a name to the new design. The system will now start 
with a new design, this means you must now define the standard values of the 
design and the data for the header.
If the command line states command, the system is ready. 



OPEN - How to open an existing design

Toolbar: Standard > Open 

Menu: File > Open

Keyboard: OPEN

With the command Open you load an already existing design. The design you are 
actually working on, will then be terminated whereby the system will ask, whether 
you want to safe the modification or not.
Thereafter you will be asked the name for the other design and the system then will 
load it. If the command line states command, the system is ready.



QSAVE - How to save a design to disk 

Toolbar: Standard > Save 

Menu: File > Save

Keyboard: QSAVE

With the command QSAVE, the actual design will be filed. Should a technical error 
occur or the program be interrupted due to an operator error, you may continue the 
work at the point where the last save has been made. 



SAVEAS - How to save a design under a new name 

Menu: File > Save As ...

Keyboard:  SAVEAS

With the command Saveas, the actual design is being filed. 

After calling up the command, the file dialog-box opens, where you must specify the 
new name. 

Note: If you want to work out a variant of the design, you can 
also use this command to copy the design to another name. 



END - How to terminate the program

Menu: File > Terminate program

Keyboard:  END

The design is filed on hard disk and the system jumps back to the operating system. 
If you modify an existing design, the last version of the design will be filed with the 
file extension .BAK.

Prior to leaving the program, the system will ask you, whether you want to save the 
modifications.



How to initialize a new design

Before you can work out a design you must put a sketch or a sample into the 
background of the screen. Sketches and samples can be read with a scanner and 
superimposed on the screen for design work.

Following these steps to initialize a new design:

●     Scan the sketch using Corel PhotoPaint.

●     Adjust the Brightness and Contrast of the image. Eventually invert the image.

●     Copy the image to the Clipboard.

●     Start ProArt/ProLace.

●     Save the drawing under the desired name. Therefore use the command 
File/Save as...

●     Run  SETUP and specify the embroidery parameters.

●     Use the command PAST to insert the image in the design.

●     Click onto the border of the image, call up  DRAWORDER and send the image 
to the back.

●     Finally move the image to the desired position.

Note: The best resolution for scanning is 150 dpi.



SETUP - How to initialize a design 

Toolbar: Standard > Setup 

Menu: File > Setup... 

Keyboard: SETUP 

This function must be called first when you  start with a new design. In a dialog-box 
you can specify all important parameters like repeat, design-height, raedle, yarn etc. 
After having defined all the parameters, the repeat, the repeat grid and the header 
are inserted in the design. 



DRAWORDER - How to change the display order

Toolbar: Standard > Draworder 

Menu:  Sketch > Draworder

Keyboard: DRAWORDER 

The DRAWORDER command changes the drawing and plotting order of any object 
in the drawing database in a way that it appears behind or in front of all other 
elements.

After calling up the command you can choose the entities, which should be modified, 
then you can choose from a menu one of the following options...

Bring to front
Choose this option to change the drawing and plotting order of any object in the 
drawing database in a way that it appears in front of all other elements.

Command: DRAWORDER
Select entities: P1
Select entities: <Ret>
> Select Bring to front from menu <

Send to back
Choose this option to change the drawing and plotting order of any object in the 
drawing database in a way that it appears behind of all other elements.

Command: DRAWORDER
Select entities: P1
Select entities: <Ret>
> Select Send to back from menu <



FORMATS - How to select the paper format 

Toolbar: Standard > Paper format 

Menu: File > Formats

Keyboard: FORMATS

Prior to plotting, you must determine how the design will be positioned on the paper. 
With larger sized designs it often is necessary to divide the design into several 
segments. This is being done with the function FORMATS. 

After calling up the command you must define the orientation. You can choose 
between the following options: 

●     Portrait

●     Landscape

●     Free

If you select Free, you can define the paper width and paper length.

If you have selected Portrait or Landscape you can choose the desired paper from a 
menu.

Finally you must specify the scale factor. You can choose between

●     1:1

●     3:1

●     6:1

●     Free

If you select Free you can define any desired scale factor.

Now a rectangle will appear marking the plot boundaries. This rectangle can be 
positioned using the normal MOVE command in order to optimize the plot area. 

If the complete design cannot be placed within this rectangle, copy the rectangle 
and position the new rectangle beside the previous one. Continue until the complete 
design is covered with rectangles. Each rectangle represents to a sheet of paper on 
the plotter. 

Attention: The selected format can never be bigger than the 
maximal plot area of the plotter.



PLOT - How to plot a design 

Toolbar: Standard > Plot/Print 

Menu: File > Plot/Print...

Keyboard: PLOT

After the plot format has been selected, you may start plotting. 

After calling- up the plot command, a dialog-box opens, where the following settings 
must be made: 

●     In the sub-menu Print Setup... select desired device (Plotter, Printer) and select 
the paper format as well as the orientation. 

●     In the Color/Width Map tab you can adjust the plot colors and line-width. 

●     In the Scale/View tab select the area, which should be plotted. The selected 
area should cover the area of a rectangle, which was designed with the command 
FORMATS . 

●     Also in the Scale/View tab you must define the scale factor with the fields 
Printed Millimeters = Drawing Units e.g. 6 = 1. 

 
All parameters will be saved. This means,  whenever you are working with the same 
paper, the same scale and with, the same pens, you only have to select the plotting 
area prior to plotting.



Note: With the option Print Preview..., you can superimpose 
on the screen the positioning of the design on the paper. This 
is important at the beginning, if you have to check the selected 
parameters. 

 



PAN - How to move the display 

Toolbar: Standard > Pan 

Menu: Display > Pan

Keyboard: PAN

If you imagine your computer screen to be a window, through which you look at a 
design, then you can display with the command PAN the design behind the window 
by moving the window.
The displacement must be defined with two points. 

Command: PAN
Pan base point: 1st point
Pan displacement point: 2nd point 

Notice: The PAN command can be called-up while carrying 
out another command. 



ZOOM - How to modify the view 

The zoom command gives you the possibility to enlarge the part of the design you 
are working on to a screen-filling size. The actual size of the entities will remain 
unchanged. They only appear larger on the screen. 

The different zoom commands have following effects: 

Command Description

 Zoom In Enlarge the display size by factor two.

 Zoom Out Reduce the display size by factor 0.5.

 Zoom Window Selection of the area by using two 
diagonal corners of a rectangle.

 Zoom Previous Will bring back the previous area on 
the screen.

 Zoom All Display of the complete design on the 
screen according to defined 
boundaries.

How to use Realtime Zoom and Pan 

With Real time Zoom/Pan can dynamically change the display content. 

Real time Zoom can be activated by simultaneously pressing the Ctrl key, the 
Shift key and the Pick-button on the mouse, and moving the mouse up/down.
On moving the mouse down, the display size will be reduced (like Zoom Out), on 
moving up the display size wil be enlarged (like Zoom In). 

Real time Pan can be activated by simultaneously pressing the Ctrl key, the Shift 
key and the Enter-button on the mouse and moving the display with the mouse to 



the desired position. 

 

Note: The ZOOM commands can be called-up while carrying 
out another command as long as no regeneration is necessary. 

 



REDRAW - How to clean the screen from 
construction points 

Toolbar: Standard > Redraw 

Menu: Display > Redraw

Keyboard: REDRAW

With the command REDRAW, the actual screen content will be newly designed. The 
image will thereby be cleaned from any construction points. 

Notice: The REDRAW command can be called-up while 
carrying out another command. 



REGEN - How to regenerate the screen 

Toolbar: Standard > Regen 

Menu: Display > Regen

Keyboard: REGEN

With the command REGEN you can newly regenerate a design from the drawing 
database. Use REGEN, when changes could not be made visible with the command 
REDRAW. 

Attention: The REGEN command cannot be called-up while 
carrying out another command! The command will be 
interrupted. 



U / Undo - How to undo a command 

Toolbar: Standard > Undo 

Keyboard: U / UNDO

With this command the last command can be canceled. The command Undo (or U 
with the key board) can be repeated indefinite until the start of the design is being 
reached. 



REDO - How to recover the previously undone 
command 

Toolbar: Standard > Redo 

Keyboard: REDO

This command is used to recover an action, which was canceled with an Undo 
command. 



ESC - How to cancel an active command

Keyboard:  ESC key

With the ESC key on the keyboard you can interrupt an active command or you can 
deactivate the handles of elements, which were activated by a previous selection or 
modification.



Basic design functions 

This chapter describes commands to design basic design entities like curves, lines 
and circles etc. All these commands are located in the Toolbar Design or in the pull 
down menu Design. 

The Design Toolbar contains the following commands...
 
 Design Toolbar 

LINE - How to design single lines 

Flyout Polyline 

Flyout Circle 

ELLIPS - How to design an ellipse 

RECTANG - How to design a rectangle 

POLYGON - How to design a polygon 

SKETCH - How to design freehand lines 

TEXT - How to insert text 

 Polyline Toolbar 

PARC - Polyarc, starting with a 3 point arc 

PARCDIR - Polyarc, with starting direction 

PLINE - Polyline, starting with a straight segment 

SPIRALE - How to design a spiral 

DROP - How to design a drop 

 Circle Toolbar 

CIRRAD - Circle, defined by radius 

CIR2P - Circle, defined by 2 points 

CIR3P - Circle, defined by 3 points 



LINE - How to design single lines 

Toolbar: Design > Line 

Menu: Design > Line

Keyboard: LINE

You design a line by defining the two end points of the line. Independent line 
segments are being designed until you end this function by pressing <Return>.

Command: LINE
From point: 1,1
To point: 1,5
From point: 2,1
To point: 2,5
From point: <Ret> 



PARC - How to design a polyarc starting with a 3 
point arc 

Toolbar: Polyline > Polyarc 3 points 

Menu:  Design > Polyarc 3 points

Keyboard: PARC

The arc is being defined via the starting point, a second point on the arc and the end 
point. The subsequent arcs are defined tangentially to the last arc and only the 
endpoint has to be defined, whereby the arc form is shown dynamically. 

You can choose from the following options...

Draw Line
If you are actually designing in the arc mode you can change to the line mode.

Direction
If an arc should not start tangentially to the last arc you can select the option 
Direction to define a starting direction for the next segment.

Second point
With this option you can specify the second point on a  3-point-arc, thereby 
changing the direction. 

Close
The curve line is automatically closed with the starting point of a polyline.

Undo
The last arc segment is canceled.

Example:

Command: PARC
Start of polyline: starting point P1
Second point: second point P2



End of arc: end point P3
Line/Direction/.../Undo/<End of Arc>: option Second point
Second point: second point P4
End of arc: end point P5
Line/Direction/.../Undo/<End of Arc>: end point P6
Line/Direction/.../Undo/<End of Arc>: <Ret>



PARCDIR - How to design a polyarc with starting 
direction 

Toolbar: Polyline > Polyarc direction 

Menu: Design > Polyarc direction

Keyboard: PARCDIR

The arc is defined by a starting point, starting direction and arc endpoint. The 
starting direction is shown as kind of rubber band, starting from the first point of the 
arc.  The subsequent arcs are defined tangentially to the last arc and only the 
endpoint has to be defined, whereby the arc form is shown dynamically.

You can choose from the following options...

Draw Line
If you are actually designing in the arc mode you can change to the line mode.

Direction
If an arc should not start tangentially to the last arc you can select the option 
Direction to define a starting direction for the next segment.

Second point
With this option you can specify the second point on a  3-point-arc, thereby 
changing the direction. 

Close
The curve line is automatically closed with the starting point of a polyline.

Undo
The last arc segment is canceled.

Example:

Command: PARCDIR
Start of polyline: starting point P1



Direction from start: start direction P2
End of Arc: endpoint P3
Line/Direction/.../Undo/<End of Arc>: option Direction
Line/Direction/.../Undo/<End of Arc>: start direction P4
End of Arc: endpoint P5
Line/Direction/.../Undo/<End of Arc>: P6
Line/Direction/.../Undo/<End of Arc>: <Ret> 

 

 



PLINE - How to design a polyline, starting with a 
straight segment 

Toolbar: Polyline > Polyline 

Menu: Design > Polyline

Keyboard: PLINE

Polylines are elements, which can contain line segments and arcs. They are however 
considered as one element.

This function is the same as the two Polyarc functions described before. The only 
difference is, that the starting element is a line and not an arc.

You can choose from the following options...

Draw arcs
If you are actually designing in the line mode you can change to the arc mode.

Close
The curve line is automatically closed with the starting point of a polyline.

Undo
The last arc segment is canceled.

Command: PLINE
Start of polyline: Start point
Arc/Distance/.../<Next point>: Endpoint 1
Arc/Distance/.../Undo/<Next point>: Endpoint 2
...
Arc/Distance/.../Undo/<Next point>: <Ret> 



SPIRALE - How to design a spiral 

Toolbar: Polyline > Spiral 

Menu:  Design > Spiral

Keyboard: SPIRALE

To construct a spiral you must define a center, the quantity of turns and the distance 
between the turns. 

Command: SPIRALE
Center point: point P1
Number of turns <0>: N=3
Distance: D=10 

If you define number of turns = 0, you can now specify the outside radius  of the 
spiral and the distance between the turns. The number of turns is calculated. 

Command: SPIRALE
Center point: point P1
Number of turns <0>: <Ret>
Outside radius: radius R
Distance: D=10



DROP - How to design a drop 

Toolbar: Polyline > Drop 

Menu:  Design > Drop

Keyboard: DROP

To construct a drop you must first specify the diameter of the circle and then the 
point of the drop.

Command: DROP
Point 1: P1
Diameter: P2
Select paddle top: P3



CIRRAD - How to design a circle, defined by radius 

Toolbar: Circle > Circle radius 

Menu: Design > Circle radius 

Keyboard: CIRRAD

The circle is constructed by defining the center and the radius of the circle. 

Command: CIRRAD
Center point: center P1
Radius: radius R 



CIR2P - How to design a circle, defined by 2 points 

Toolbar: Circle > Circle 2 points 

Menu: Design > Circle 2 points

Keyboard: CIR2P

This command defines the circle with the 2 end points of the diameter. 

Command: CIR2P
Point 1: point P1
Point 2: point P2 



CIR3P - How to design a circle, defined by 3 points 

Toolbar: Circle > Circle 3 points 

Menu: Design > Circle 3 points

Keyboard: CIR3P

This command defines the circle with 3 points on the periphery of the circle. 

Command: CIR3P
Point 1: point P1
Point 2: point P2
Point 3: point P3 

 



ELLIPSE - How to design an ellipse 

Toolbar: Design > Ellipse 

Menu:  Design > Ellipse

Keyboard: ELLIPSE

An ellipse is being designed by defining one axis and the width of the second axis. 

Command: ELLIPSE
Center/<First endpoint of axis>: P1
Second endpoint of axis: P2
Other side: P3

Another possibility is to specify the center and points on the two axis. In this case 
you must choose the option Center instead of defining the first endpoint of the axis.

Command: ELLIPSE
Center/<First endpoint of axis>: C
Center point: center of ellipse
Second endpoint of axis: P2
Other side: P3



RECTANG - How to design a rectangle 

Toolbar: Design > Rectangle 

Menu: Design > Rectangle

Keyboard: RECTANG

With this function you can design a rectangle. 

Two diagonal points will define the rectangle. Thereafter the orientation of the 
rectangle can be determined. 

Command: RECTANG
First corner: point P1
Other corner: point P2
Angle<0>: Angle A



POLYGON - How to design a regular polygon 

Toolbar: Design > Polygon 

Menu: Design > Polygon

Keyboard: POLYGON

Using the command Polygon you can design a polygon with 3 up to 1024 sides. 
First the system will ask the number of sides, then it will request the center of the 
polygon and finally it will ask for the outside radius of the polygon. 

Command: POLYGON
Number of sides<4>: 5
Inside/<Center point>: P1
Radius: P2 

You can also define the polygon via the inside radius of the polygon. In this case you 
must choose the option Inside before you define the center point. 

Command: POLYGON
Number of sides<4>: 5
Inside/<Center point>: I
Inside/<Center point>: P1
Radius: point in the middle of a segment 



SKETCH - How to design freehand lines  

Toolbar: Design > Freehand 

Menu:  Sketch > Freehand

Keyboard: SKETCH

With the command SKETCH you can design freehand sketches. To sketch, trace 
with the mouse the desired contours. The system creates a series of lines. The 
length of these line segments and thereby the resolution can be defined after calling 
up the command. Please limit yourselves to the absolute necessary precision, as a lot 
of data will accumulate. 

While sketching, the normal commands are not available, and the button menu is 
being replaced by an own button menu for sketching. 

Button definition: 

●     Pick button - The pick button (left mouse button) is used to raise and sink the 
pen (Pen up / Pen down).

●     Right button - By pressing the right button, the freehand command is 
terminated and the freehand lines are memorized. 

On sketching, the curser is changed to a pen. 



TEXT - How to insert text  

Toolbar: Design > Text 

Menu: Design > Text

Keyboard: TEXT

With the command TEXT you can position text in the design. Text will be inserted in 
the actual text style. 

First specify the insertion point of the text. The text will be positioned left justified to 
this point. Next the text height and finally the insertion angle have to be defined 
prior to text input.

Command: TEXT
Insertion point: Basepoint
Height <1.50>: <Ret> if not defined with style
Angle <0>: <Ret>
Text: This is a text 



Editing functions

In this chapter you find the commands to manipulate design elements. All editing 
functions are located in the Toolbar Modify or in the pull down menu Edit. 

 

 Modify Toolbar 

ERASE - How to erase selected entities 

MOVE - How to move selected entities 

OFFSET - How to construct a parallel 

MIRROR - How to mirror selected entities 

ROTATE - How to rotate selected entities 

SCALE - How to change the size of entities 

Flyout Copy 

Flyout Array 

COPYROT - How to copy, rotate and scale entities 

COPYMIR - How to copy, mirror and scale entities 

COPYREP - How to copy entities to the repeat 

COPYALOV - How to copy an allover 

STRETCH - How to stretch points of entities 

TRIM - How to trim entities to a boundary 

EXTEND - How to extend entities to a boundary 

JOIN - How to join elements in their corners 

Flyout Break 

EXPLODE - How to break a polyline or a block apart 

PLEDIT - How to modify a polyline

Flyout Change 

 Copy Toolbar 

COPY - How to make a copy of entities 

COPYM - How to make multiple copies of entities 

 Array Toolbar 

PARRAY - How to arrange entities in a polar array 



RECARRAY - How to arrange entities in a rect. array 

 Break Toolbar 

BREAK - How to erase a part of an entity 

CUT - How to break an object apart 

 Edit polyline Toolbar 

PLMAKE - How to join entities to a polyline 

PLADDPT - How to add vertices to a polyline 

PLWIDTH - How to change the width of entities 

PSPLINE - How to lay a spline through vertices 

CURVE - How to lay a curve through vertices 

DECURVE - How to erase curves 

 Change Toolbar 

DDCHPROP - How to change characteristics of entities 

XCOLOR - How to change the entity color 

TOFRONT - How to bring entities on top 

TOBACK - How to bring entities to back 

DDATTE - How to edit the header 

  



ERASE - How to erase selected entities 

Toolbar:  Modify > Erase 

Menu:  Edit > Erase

Keyboard:  ERASE

The command ERASE allows erasing undesired entities in the design. All object 
selection methods are available to define elements to be erased. 

Attention: You should not use this command to erase 
automatically generated embroidery elements. To erase 
embroidery elements use the  DELEMB command.

 



MOVE - How to move selected entities 

Toolbar: Modify > Move 

Menu: Edit > Move 

Keyboard: MOVE

The command MOVE allows to move entities by a definable displacement. 

First select the entities to be moved. The displacement can be defined with two 
points. 

Command: MOVE
Select entities: select P1
Select entities: <Ret>
Base point of displacement: base point P2
Second point of displacement: insertion point P3 



PARALLEL - How to construct a parallel line to an 
entity 

Toolbar: Modify > Parallel 

Menu: Edit > Parallel 

Keyboard: PARALLEL

If you want to design a parallel line to an entity with a defined offset distance or to a 
point select the command PARALLEL. 

First define the parallel distance, next select the element to be offset and finally 
define the side to offset.

Command: PARALLEL
Distance <last>: D
Select entity: P1
Point on side: P2
Select entity: P1
Point on side: P3
Select entity: <Ret>

Attention: With intersecting polylines or acute corners 
undesired results may happen. With the trimming commands, 
possible corrections can be made. Sometimes it is useful to 
break the polyline apart and offset the single segments 
individually.



MIRROR - How to mirror selected entities

Toolbar: Modify > Mirror 

Menu: Edit > Mirror

Keyboard: MIRROR

If you want to mirror entities in a design you can use the command MIRROR.

First select the entities to be mirrored and then specify the mirror line. The mirror 
line can be defined with 2 points or by selecting an existing line. 

Finally you have to define whether the original entity should be erased or not.

The mirror line is defined with 2 points
If the system cannot find a line or a polyline at the first point of the mirror line, the 
system asks for the second point of the mirror line.

Command: MIRROR
Select entities: P1
Select entities: <Ret>
Select mirror line or first point of mirror line: P2
Second point: P3

Hint: In this example you should find the points P2 and P3 
with the entity snap function F6 Endpoint.

The mirror line is an existing line or polyline
If the system finds a line or a polyline at the point where you specify the first point 
of the mirror line, the system uses this line or polyline as mirror line.

Command: MIRROR



Select entities: P1
Select entities: <Ret>
Select mirror line or first point of mirror line: P2



ROTATE - How to rotate selected entities

Toolbar: Modify > Rotate 

Menu: Edit > Rotate 

Keyboard: ROTATE

If you want to rotate entities of your design you can use the command ROTATE. 
The selected entities can be rotated around a specified base point. The dialog is as 
follows.

Command: ROTATE
Select entities: P1
Select entities: <Ret>
Base point: P2
<Rotation angle>/Reference: P3

If you enter R for Reference, instead of defining a rotation angle, the actual 
insertion angle of an entity can be corrected to a given value. The dialog for such a 
case is as follows.

Command: ROTATE
Select entities: P1
Select entities: <Ret>
Base point: P2
<Rotation angle>/Reference: R
Reference angle <0>: P2



Second point: P3
New angle: P4



SCALE - How to change the size of entities

Toolbar: Modify > Scale 

Menu: Edit > Scale 

Keyboard: SCALE

With the command SCALE the size of entities can be changed.

After selecting the entity, a base point and a scale factor must be defined.
Command: SCALE
Select entities: P1
Select entities: P2
Select entities: <Ret>
Base point: P3
<Scale factor>/Reference: scale factor

If you enter R for Reference, instead of defining a scale factor, the actual size of an 
entity can be corrected to a given value. The dialog for such a case is as follows.

Command: SCALE
Select entities: P1
Select entities: P2
Select entities: <Ret>
Base point: P3
<Scale factor>/Reference: R
Reference length <1>: P3
Second point: P4
New length: P5



COPY - How to make a copy of entities 

Toolbar: Copy > Copy single 

Menu: Edit > Copy > Copy single 

Keyboard: COPY 

With the command COPY you can make a copy of one or more entities.
After object selection the system requests the base point. Next the system requests 
the insertion point.

Command: COPY
Select entities: select items P1
Select entities: <Ret>
Base point or displacement: base point P2
Second point of displacement: insertion point P3



COPYM - How to make multiple copies of entities 

Toolbar: Copy > Copy multiple 

Menu: Edit > Copy > Copy multiple 

Keyboard: COPYM 

With the command COPYM you can make multiple copies of one or more entities.
After object selection the system requests the base point. Next the system requests 
insertion points until you press <Return>. On each point a new copy will be placed.

Command: COPYM
Select entities: select items P1
Select entities: <Ret>
Base point or displacement: base point P2
Second point of displacement: insertion point P3
Second point of displacement: insertion point P4
Second point of displacement: <Ret>



POLARRAY - How to arrange entities in a polar 
array

Toolbar: Array > Polar array 

Menu: Edit > Copy > Polar array

Keyboard: POLARRAY

To copy elements in a polar array, select the entities, which you want to have 
arranged, then define the center point of the array, the number of elements and 
finally the angle, on which the elements must be copied.

Command: POLARRAY
Select entities: P1
Select entities: <Ret>
Center point: P2
Number of items: 6
Angle to fill (+=CCW,-=CW) <360>: <Ret>

Note: If you enter a negative angle to fill, the rotation will be 
clock wise otherwise anti clock wise.



RECARRAY - How to arrange entities in a 
rectangular array

Toolbar: Array > Rectangular array 

Menu: Edit > Copy > Rectangular array

Keyboard: RECARRAY

To copy elements in a rectangular array, select the entities, which you want to have 
arranged, then specify number of rows and columns and finally specify the distance 
between rows and column.

Command: RECARRAY
Select entities: P1
Select entities: <Ret>
Number of rows (—-) <1>: N1=2
Number of columns (|||) <1>: N2=3
Distance between rows (—-): B
Distance between columns (|||): A



COPYROT - How to copy, rotate and scale entities 

Toolbar: Modify > Copy rotate 

Menu: Edit > Copy > Copy rotate

Keyboard: COPYROT

With this command you can copy, scale and finally rotate selected elements several 
times.
After selecting the object, you must define the displacement by picking two points.

The second point is also the rotation point, around which the entities can be rotated 
dynamically. If you enter R for Reference, you can first specify a reference angle 
and then the new angle.

Finally you can scale the copied entities by picking the opposite side of the entities 
and stretching them dynamically.

 
Command: COPYROT
Select entities: select leave
Select entities: <Ret>
Base point of displacement: P1
Second point of displacement: P2
Reference/<Rotation angle>: P3 
Reference length <1>: P4
New length: P5
Second point of displacement: <Ret>

Example with rotation by Reference:
Command: COPYROT
Select entities: select leave
Select entities: <Ret>
Base point of displacement: P1
Second point of displacement: P2
Reference/<Rotation angle>: R
Reference angle: specify actual angle
New angle: specify new angle 
Reference length <1>: P4
New length: P5
Second point of displacement: <Ret>



See also the description of the command ROTATE .



COPYMIR - How to copy, mirror and scale entities

Toolbar: Modify > Copy mirror 

Menu: Edit > Copy > Copy mirror

Keyboard: COPYMIR

With this command you can copy, scale and finally mirror selected elements several 
times.
After selecting the object, you must define the displacement by picking two points.
Next you can mirror the entities dynamically to the desired position.
Finally you can scale the copied entities by picking the opposite side of the entities 
and stretching them dynamically.

Command: COPYMIR
Select entities: select leave
Select entities: <Ret>
Base point of displacement: P1
Second point of displacement: P2
Second point of mirror line: P3
Reference length <1>: P4
New length: P5
 



COPYREP - How to copy entities to the repeat 

Toolbar: Modify > Copy repeat 

Menu: Edit > Copy > Copy repeat

Keyboard: COPYREP

With this command you can copy the selected elements to the repeat. The copied 
elements are laid on the layer AMD_RAPPORT_LR.

How to copy selected elements to the repeat
After calling up the command you must first select the elements, which you want to 
copy to the repeat. After the selection a menu opens where you can specify weather 
you want to copy to the right or to the left repeat.

With the option Stitches you can additionally define if you want to copy with or 
without stitch data. If Stitches=Yes, selected elements are copied with stitch data, 
if Stitches=No only the shape of the element will be copied.

Command: COPYREP
Select entities: select
Select entities: <Ret>

How to copy the whole design
After calling up the command you can first select elements. If you terminate the 
selection with <Ret>, the system automatically copies all elements on layer 
AMD_WORK to the right and to the left repeat and all embroidery data are 
removed from the copied elements.

Command: COPYREP
Select entities: <Ret>

Note: Before automatically copying elements to the right and 
to the left, COPYREP erases all elements, which are on Layer 
AMD_REPEAT_LR. Hence it is possible to bring the repeat up 
to date with this command after having made changes on the 
design. 



COPYALOV - How to copy an allover 

Toolbar: Modify > Copy allover 

Menu: Edit > Copy > Copy allover

Keyboard: COPYALOV

With this command you can copy and mirror the selected elements around a vertical 
or a horizontal mirror line. This function is used to mirror and copy elements of an 
allover.

After calling up the command you must select the elements and specify the 
displacement via 2 points. Finally you specify the mirror axis with a 3rd point. If you 
specify the 3rd point above or below the insertion point of the copy P2, the elements 
are mirrored vertically. Is the 3rd point right or left from the insertion point P2, the 
elements are mirrored horizontally.

 
Command: COPYALOV
Select entities: select
From point: P1
Second point of displacement: P2 
Second endpoint of axis: P3



STRETCH - How to stretch points of entities

Toolbar: Modify > Stretch 

Menu: Edit > Trim > Stretch

Keyboard: STRETCH

With this command you can move defined points of an element, whereby the 
remaining part of the elements remains unchanged. Defined points are end points of 
lines, arcs and polylines as well as cross points of polylines.

First mark the corners which have to be displaced with Crossing window.
Then the displacement is determined with the base point and the new point.

Command: STRETCH
Select entities to stretch by crossing-window...
Select entities: P1
Other corner: P2
Select entities: <Ret>
Base point of displacement: P3
Second point of displacement: P4



TRIM - How to trim entities to a boundary

Toolbar: Modify > Trim 

Menu: Edit > Trim > Trim

Keyboard: TRIM

This command is the complement of the command  EXTEND. With this command 
entities can be trimmed in such a way to end exactly at the boundary of other 
entities.
First define the trimming edge on which the elements must be trimmed.
Then select the entities to be trimmed by picking the part of the object that has to 
be trimmed. With <Ret> you can access the parameter menu. To terminate the 
command select End command from the menu.

Command: TRIM
Select cutting edge (s)...
Select entities: P1
Select entities: <Ret>
Select object to trim<Parameters>: P2
...
Select object to trim<Parameters>: Px
Select object to trim<Parameters>: <Ret>

In the parameter menu you can choose from the following options...

Actual mode
Switch between Trim and Extend mode.

Extend edge
Choose Extend edge to trim selected entities to an implied boundary. 

New boundary
You can choose a new boundary as trimming edge. 



Fence
With this option you define a cutting line. All elements touched by it are trimmed.

Done
End the menu and continue trimming.

End command
Terminate the command.



EXTEND - How to extend entities to a boundary

Toolbar: Modify > Extend 

Menu: Edit > Trim > Extend

Keyboard: EXTEND

This command is the complement of the command  TRIM. You can extend 
existing entities in order to end at boundaries, defined by other entities.
First select the boundary (or boundaries) up to which the elements should be 
extended. Then select the object to be extended by picking the side of the object 
that must be extended. With <Ret> you can access the parameter menu. To 
terminate the command select End command from the menu.

Command: EXTEND
Select boundary edge.(s)...
Select entities: P1
Select entities: <Ret>
Select object to extend<Parameters>: P2
...
Select object to extend<Parameters>: Px
Select object to extend<Parameters>: <Ret>

In the parameter menu you can choose from the following options...

Actual mode
Switch between Trim and Extend mode.

Extend edge
Choose Extend edge to extend selected entities to an implied boundary. 

New boundary
You can choose a new boundary up to which the elements should be extended. 

Fence



With this option you can define a cutting line. All elements touched by it are 
extended to the boundary.

Done
End the menu and continue extending entities.

End command
Terminate the command.

 



JOIN - How to join elements in their corners

Toolbar: Modify > Join 2 entities 

Menu: Edit > Trim > Join 2 entities

Keyboard: JOIN

With this command you may join arcs, lines and polylines. The entities will be 
extended or trimmed if necessary.
The joined elements will automatically be changed into a polyline.

After launching the JOIN-command, select the entities at the endpoints, which have 
to be joined.

Command: JOIN
Select polyline/<Radius=0.0>: P1
Select object: P2

With the JOIN command you can also creates a fillet, or rounded corner. To define 
the radius click the right mouse button instead of selecting the first polyline. Now a 
menu opens where you can define the fillet radius. After having defined the radius 
select the entities at the endpoints, which have to be filleted.

 



BREAK - How to erase a part of an entity

Toolbar: Break > Break 2 points 

Menu: Edit > Trim > Break 2 points

Keyboard: BREAK

With this command you can erase a part of a line, a polyline, a circle or an arc.
First select the object to be broken, then define with two points the section to be 
erased.

Command: BREAK
Select object: P1
First point: P2
Second point: P3

Attention: When you want to erase a section of an arc or a 
polyline, the two points must be defined counterclockwise.



CUT - How to break an object apart

Toolbar: Break > Cut 

Menu: Edit > Trim > Cut

Keyboard: CUT

With this command an element will be broken into two parts. The screen image will 
not change.
First select the object to be broken, then define the break point.

Command: CUT
Select object: select object to break
Break point: point on element

This command is mainly used with fillings and hatches whereby exact contours are 
necessary. Line overlap results in hatch error.



EXPLODE - How to break a polyline or a block 
apart

Toolbar: Modify > Explode 

Menu: Edit > Trim > Explode

Keyboard: EXPLODE

If you want to break a block or a polyline into its original segments, choose the 
command EXPLODE. The image of the broken elements on the screen will not 
change.
The command EXPLODE only affects the last level. If the polyline is part of a block 
and the command origin is used with the block, the block will be broken, however, 
the polyline will not be affected. The command must, if so desired, also be used with 
the polyline.

You can also convert embroidery objects like blattstitches, edges, etc. to manually 
punched sequences or manually punched sequences to polylines.

Attention: Blocks inserted with different x and y factors 
cannot be broken-up again!

 



PLEDIT - How to modify a polyline

Toolbar: Modify > Edit polylines 

Menu: Edit > Polyline > Edit

Keyboard: PLEDIT

With the command PLEDIT you can modify polylines. After calling up the command 
a menu is opened.

In the menu you can choose from the following options...

Join polylines
From individual lines, arcs and polylines you can make one single polyline. You only 
have to select the elements to be joined.

Attention: The end points of the single elements must be 
joined exactly.

Add point
You can insert vertices in an existing polyline.

Select entity: select polyline
Insertion point: new vertice

Invert
The direction of a polyline can be changed. This means, the polylines start and end 
will be inverted.

After selecting a polyline, the actual start of the polyline will be indicated by a cross 
and from a popup menu you can choose weather you want to change the direction 
or not. If you select Invert, the direction of the polyline will be changed and the 
new endpoint will be indicated by a cross. If you select Cancel from the menu, you 
terminate the command without changing the polyline.

Note: This command is mainly used in conjunction with the 
command

 CHAIN2P.

Wide polyline
You can define the width of polylines and circles. This is specially useful when you 
want to represent edges as solid elements in a sketch representation.
After calling up the command you must select the polylines, for which you want to 
define a width. Next you must specify the width. Finally the system makes a copy of 
all selected elements. The copied elements get the specified width and are moved to 
Layer 2.

Select entities: select



Select entities: <Ret>
Width <0.00>: 0.7

Note: With  Toback you can move the area below all other 
elements, and with  ToFront you can move the area to the 
top of all other elements.

Spline
After selecting a polyline, a spline will be laid through the vertices of the polyline.

Curve
After selecting a polyline, a curve will be laid through the vertices of the polyline. 
The curve will be laid directly through each vertices.

Erase curve
A polyline, through which a spline or a curve line has been laid, is being changed to 
a normal polyline with straight line segments.



PLMAKE - How to join entities to a polyline 

Toolbar: Change polyline > Join polylines 

Menu:  -

Keyboard:  PLMAKE

From individual lines, arcs and polylines you can make one single polyline. You only 
have to select the elements to be joined.

Attention: The end points of the single elements must be 
joined exactly.



PLADDPT - How to add vertices to a polyline

Toolbar: Change polyline > Add point 

Menu:  -

Keyboard:  PLADDPT

With the command PLADDPT you can insert vertices in an existing polyline.
Command: PLADDPT
Select entity: select polyline
Insertion point: new vertice



PLWIDTH - How to change the width of entities

Toolbar: Change polyline > Polyline width 

Menu:  -

Keyboard:  PLWIDTH

With this function you can define the width of polylines and circles. This is specially 
useful when you want to represent edges as solid elements in a sketch 
representation.
After calling up the command you must select the polylines, for which you want to 
define a width. Next you must specify the width. Finally the system makes a copy of 
all selected elements. The copied elements get the specified width and are moved to 
Layer 2.

Command: PLWIDTH
Select entities: select
Select entities: <Ret>
Width <0.00>: 0.7

Note: With  Toback you can move the area below all other 
elements, and with  ToFront you can move the area to the 
top of all other elements.



PSPLINE - How to lay a spline through vertices

Toolbar: Change polyline > Spline 

Menu:  -

Keyboard:  PSPLINE

After picking a polyline, a spline will be laid through the vertices of the polyline.



CURVE - How to lay a curve through vertices

Toolbar: Change polyline > Curve 

Menu:  -

Keyboard:  CURVE

After picking a polyline, a curve will be laid through the vertices of the polyline. The 
curve will be laid directly through each vertices.



DECURVE - How to erase curves

Toolbar: Change polyline > Erase curve 

Menu:  -

Keyboard:  DECURVE

A polyline, through which a spline or a curve line has been laid, is being changed to 
a normal polyline with straight line segments.



DDCHPROP - How to change characteristics of 
entities

Toolbar: Change > Properties 

Menu:  Edit > Change > Properties

Keyboard: DDCHPROP 

With this command element characteristics, such as color, linetype, layer etc. can be 
modified.
After selecting the command and the entities, which must be modified a dialog-box 
will appear. The desired changes can then be carried out interactively.

Attention: Element characteristics of automatically created 
entities may not be changed. Changes of these characteristics 
may result in system error.



XCOLOR - How to change the entity color

Toolbar: Change > Change color 

Menu:  Edit > Change > Change color

Keyboard: XCOLOR 

With the command XCOLOR the color of selected entities can be changed.
Command: XCOLOR
Select entities: select
Select entities: <Ret>
New color: red

Attention: Element characteristics of automatically created 
entities may not be changed. Changes of these characteristics 
may result in system error.



TOFRONT - How to bring entities on top

Toolbar: Change > To front 

Menu:  Edit > Change > To front

Keyboard: TOFRONT 

The TOFRONT command changes the drawing and plotting order of any object in 
the drawing database in a way that it appears on top of all other elements.

Command: TOFRONT
Select entities: P1
Select entities: <Ret>



TOBACK - How to bring entities to back

Toolbar: Change > To background 

Menu:  Edit > Change > To background

Keyboard: TOBACK 

The TOBACK command changes the drawing and plotting order of any object in the 
drawing database in a way that it appears behind of all other elements.

Command: TOBACK
Select entities: P1
Select entities: <Ret>



DDATTE - How to edit the header

Toolbar: Change > Change header  

Menu: Edit > Change > Header...

Keyboard:  DDATTE

The command DDATTE allows you to correct the texts, entered in the header. After 
calling up this command a dialog-box will appear with all actual data of the header. 
This data can be edited as normal text. 

After having corrected the texts close the dialog-box with OK. If you do not want the 
changes to be carried out close with Cancel. 



Construction aids 

In this chapter commands are described, which can serve to construct a design or 
parts of it. All these functions are located in the Toolbar Construct or in the pull 
down menu Construct.

The Construct Toolbar contains the following commands...
 
 Construct Toolbar

Flyout Inquiry

AUXLIN - Auxiliary lines

Flyout Fill

CHAIN2P - How to arrange 2 point blocks

CHAINC - How to arrange center blocks

MODULE - How to work with modules

Flyout Block see Chapter 6

 Inquiry Toolbar

COUNTSTI - How to count stitches of a design (not yet 
punched)

DIST - How to measure the distance between points 

ELENGTH - How to determine the length of an element

DIMLINEAR - How to insert a dimension

 Auxiliary lines Toolbar

HHORI - How to insert a horizontal auxiliary lines

HVERT - How to insert a vertical auxiliary lines

HPERP - Auxiliary line, perpendicular to

HGEN - How to insert a rotated auxiliary lines

HGRID - How to insert an auxiliary grid

HFLOWER - How to insert a construct aid for flowers

HDEL - How to erase auxiliary lines

 Fill Toolbar

PATFILL - How to fill an area with a pattern

ARCFILL - How to fill an area with arcs



AREAFILL - How to fill an area with color

BORDER - How to design a polyline around an area

Other functions in the pull down menu

The following command cannot be selected from a toolbar. It must be called up from 
the pull down menu Construct.

 MANSTI - How to design single stitches 



DIST - How to measure the distance between 
points 

Toolbar: Inquiry > Distance 

Menu:  Measure > Distance

Keyboard: DIST 

With the command DIST you can measure the distance between two points.
After having defined two points the distance between the points and the angle is 
shown. 

Command: DIST
From point: point 1
To point: point 2



ELENGTH - How to determine the length of an 
element 

Toolbar: Inquiry > Element length 

Menu:  Measure > Element length

Keyboard: ELENGTH 

With the command ELENGTH you can determine the length of an object. After 
calling up the command, you must select the element, which must be measured. 

Command: ELENGTH
Select entity: select



DIMLINEAR - How to insert a dimension 

Toolbar: Inquiry > Dimension 

Menu:  Measure > Dimension

Keyboard: DIMLINEAR 

With this command you can insert a horizontal or vertical dimension. After calling up 
the command, you must specify two points, then the position of the dimension. 

Command: DIMLINEAR
From point: P1
To point: P2
Dimension line location: P3 



AUXLIN - How to design auxiliary lines

Toolbar: Construct > Auxiliary lines 

Menu: Construct > Auxiliary lines

Keyboard: AUXLINE 

With the command AUXLINE you can design and erase various auxiliary lines. 
Additionally con switch on/off the layer auxiliary lines. After calling up the command 
a menu is opened.

In the menu you can choose from the following options...

Horizontal
With this option a horizontal auxiliary line is inserted, which is limited by the design 
boundaries. Definition is made by means of the insertion point. 

Insertion point: P1
Insertion point: <Ret> 

Vertical
With this option a vertical auxiliary line is inserted, which is limited by the design 
boundaries. Definition is made by means of the insertion point. 

Insertion point: P1
Insertion point: <Ret> 

Angle
With this option an auxiliary line with a definable insertion angle can be inserted. 
The line is limited by the design boundaries. Definition is being done using an angle 
and the insertion point. 



Angle <45>: 135
Insertion point: P1
Insertion point: <Ret> 

Perpendicular
With this option an auxiliary line, perpendicular to another line, can be inserted. The 
line is limited by the design boundaries. Definition is being done by picking the 
reference line and the insertion point. 

Select object: P1
Insertion point: P2
Insertion point: <Ret> 

Divide polyline
You can divide a polyline in equal segments. The division points are marked with 
small circles.

After having selected this option you can choose the polyline, which you want to 
have divided. Next you can specify how many segmentation points you want to 
have.

Define number of segments

Just specify the number of segmentation points N.

Select guide line: P1
Number of Segments<0>: 6

Define size of a segment



Instead of specifying the number of segments confirm with <Ret>. A menu opens, 
where you can specify the distance between the segmentation point A.

Additionally you can define via the option Corner how the system handles corners.
If Corner=Yes, the system divides from corner to corner to make sure that every 
corner has a segmentation point. In curves with a small radius the distance between 
the segmentation point will automatically be reduced.
If Corner=No the system ignores corners and the distance between the 
segmentation points is always same. 

Corner = Yes         Corner = No
 

Select guide line: P1
Number of Segments<0>: <Ret>

Flower
With this option you can draw  three segmented circles. This grid can be used  to 
construct a flower. 

First define the center point of the construction, then the corresponding radius of the 
three circles and finally specify the number of segments.



Center: P1
1. radius: P2
2. radius: P3
3. radius: P4
No. of segments: 10

Note: If you want to design a flower with 5 paddles we 
recommend to specify 10 segments. In this way you have also 
the center line for each paddle.

Grid
With this option you can fill a defined area with a grid. 

The area is defined using the diagonal points of a rectangle. Thereafter you select 
number of rows and columns, in which the rectangle has to be divided. 

First corner: P1
Second corner: P2
Number of rows (—-) <1>: 3
Number of columns (|||) <1>: 4

Layer on



Switch the auxiliary layer on.

Layer off
Switch the auxiliary layer off.

Delete
With this option you erase auxiliary lines that originate from this command, or 
elements, which are on the layer AMD_AUXLIN. 

Done
Terminate the command

 



HHORI - How to insert a horizontal auxiliary lines 

Toolbar: Auxilary lines > Horizontal 

Menu:  -

Keyboard:  HHORI

With this command a horizontal auxiliary line is inserted, which is limited by the 
design boundaries. Definition is made by means of the insertion point. 

Command: HHORI
Insertion point: P1
Insertion point: <Ret> 



HVERT - How to insert a vertical auxiliary lines 

Toolbar: Auxilary lines > Vertical 

Menu:  -

Keyboard:  HVERT

With this command a vertical auxiliary line is inserted, which is limited by the design 
boundaries. Definition is made by means of the insertion point. 

Command: HVERT
Insertion point: P1
Insertion point: <Ret> 



HPERP - How to insert an auxiliary line, 
perpendicular to another line 

Toolbar: Auxilary lines > Perpendicular 

Menu:  -

Keyboard:  HPERP

With this command an auxiliary line, perpendicular to another line, can be inserted. 
The line is limited by the design boundaries. Definition is being done by picking the 
reference line and the insertion point. 

Command: HPERP
Select object: P1
Insertion point: P2
Insertion point: <Ret> 



HGEN - How to insert a rotated auxiliary lines 

Toolbar: Auxilary lines > Angle 

Menu:  -

Keyboard:  HGEN

With this command an auxiliary line with a definable insertion angle can be inserted. 
The line is limited by the design boundaries. Definition is being done using an angle 
and the insertion point. 

Command: HGEN
Angle <45>: 135
Insertion point: P1
Insertion point: <Ret> 



HGRID - How to insert an auxiliary grid 

Toolbar: Auxilary lines > Grid 

Menu:  -

Keyboard:  HGRID

With the command HGRID you can fill a defined area with a grid. 

The area is defined using the diagonal points of a rectangle. Thereafter you select 
number of rows and columns, in which the rectangle has to be divided. 

Command: HGRID
First corner: P1
Second corner: P2
Number of rows (—-) <1>: 3
Number of columns (|||) <1>: 4



HFLOWER - How to insert a construct aid for 
flowers 

Toolbar: Auxilary lines > Flower 

Menu:  -

Keyboard:  HFLOWER

With this command you can draw  three segmented circles. This grid can be used  to 
construct a flower. 

First define the center point of the construction, then the corresponding radius of the 
three circles and finally specify the number of segments.

Command: HFLOWER
Center: P1
1. radius: P2
2. radius: P3
3. radius: P4
No. of segments: 10

Note: If you want to design a flower with 5 paddles we 
recommend to specify 10 segments. In this way you have also 
the center line for each paddle.



HDEL - How to erase auxiliary lines 

Toolbar: Auxilary lines > Erase auxilary lines 

Menu:  -

Keyboard:  HDEL

With this command you erase auxiliary lines that originate from commands such as 
HFLOWER, HGRID, HVERT etc. Or elements, which are on the layer 
AMD_AUXLIN. 

 



PATFILL - How to fill an area with a pattern 

Toolbar: Fill > Fill with pattern 

Menu: Construct > Fill with pattern...

Keyboard: PATFILL

With the command PATFILL, filling effects can be exactly positioned in a 
determined area.

An area can be filled in 3 steps:

●     After calling-up the command select the area to be filled.

●     Selection of the desired filling effect from the dialog-box.

●     Fit in the filling effect in the desired area.

 
After having selected the filling effect, you can position the effect with the keyboard 
or you can enter a popup menu, where you can specify  the parameters for the 
filling effect. You enter the parameter menu with <Ret> or by clicking with the right 
mouse button.

In the parameter menu you can choose from the following options...

Size
Pattern size in mm. This value defines the length of a single element of the effect. 

Angle
Insertion angle of the pattern in degrees 

Size step



With the + and - keys you can increase or reduce the size of the filling effect by a 
certain value. Size step defines the change in size for one step. 

Angle step
With the / and * keys you can rotate the effect by a certain value. Angle-step defines 
the rotation angle for one step. 

Displacement
Displacement, by which the filling effect will be moved by pressing the key once 
(7,8,9,4,6,1,2,3). 

Done
Leave the menu. You can continue moving the filling effect with the keyboard. 

Build
Build the effect and terminate the command. 

Cancel
The effect will be removed and the command is terminated. 

How to adjust the effect with the keyboard

Using the number block on the key board, the hatch can be moved, enlarged, 
reduced and rotated.

Attention: The number block must be set up for number 
entry.

Key functions

+   Enlarge the effect according to the defined value.

-    Reduce the effect according to the defined value..

*   Rotate the effect according to the selected angle clockwise.

/    Rotate the effect according to the selected angle counterclockwise.

7   Move the effect according to the selected value to the left up.

8   Move the effect according to the selected value up.

9   Move the effect according to the selected value to the right up.

4   Move the effect according to the selected value to the left.

6   Move the effect according to the selected value to the right.

1   Move the effect according to the selected value to the left down.



2   Move the effect according to the selected value down.

3   Move the effect according to the selected value to the right down.

Command: PATFILL
Select boundary edge(s)...
Select entities: select
Select entities: <Ret> 

>> Select pattern from dialog-box <<

The pattern will be inserted. Now it must be positioned with the 
keyboard and the popup menu.

Attention: The area must be closed, otherwise it cannot be 
filled!

Hexagon cheap and middle version

First fill the area with the corresponding filling effect.

To design the stitches, you must use stitch automatic STEP. When you apply the 
STEP automatic, the number of stitches per segment must be set to 1.

Hexagon with wiggle stitch

First fill the area with the corresponding filling effect.

 
To design the wiggle stitches, you must use stitch automatic WIGGLE. When you 



apply the automatic, the stitch distance must be set to the length of a hexagon side.



ARCFILL - How to fill an area with arcs 

Toolbar:  Fill > Fill with arcs 

Menu:  Construct > Fill with arcs

Keyboard:  ARCFILL

With the command ARCFILL you can fill an area with polyarcs or polylines. The 
inclination polylines must be constructed before calling up the command.

The area can be represented by a single closed polyline or by a circle, or it can be 
represented by two polylines. In case of two polylines, the area must be between 
the two polylines.

Hint: If the boundary of the area is made up of more then two 
polylines, you can use the command  BORDER to generate 
a single polyline, which is surrounding the desired area.

Before you can fill the area you must design the inclination polylines.

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button.

Command: ARCFILL
Select boundary edge 1/<Parameter>: <Ret> 

The following parameters can be defined...

Menu entry Description

Raedle You can select the desired Raedle from a 
menu. If you change the Raedle, also the 
Density will be adjusted according this 
value.

Density Ray distance A in millimeter

Random The rays can have a  random length. The 
random part is always outside (at the end of 
the inclination polylines).

The parameter defines the relation between 
full ray length and random ray length. This 
value must be specified in percent (See upper 
illustration).

Example: If the ray length is 100 mm and 
the value is 80%, the random ray length can 
vary from 20 to 100 mm.



Random=30%                Random=70%

Guide line(s) With additional guide lines you can get a 
smoother distribution of the arcs. The guide 
lines must also be constructed before you can 
call up the command.

Done Exit from the menu and continue with 
selecting boundaries.

Cancel Interrupt the command

 
If the parameters are defined correctly select first the area boundaries. Thereafter 
select the previously designed inclination polylines.

To fill an area with polylines, the following rules must be respected:

●     All inclination polylines B must be designed in the same direction.

●     All inclination polylines B must be designed with the same number or line 
respectively arc segments.

●     You cannot mix arc and curve segments in an inclination polyline.

●     An inclination polyline made of arcs must not have corners.

●     The inclination polylines B must be selected in the proper order.

●     If you want to fill an area with rays of random length, the random part is always 
on the side of the end point of the inclination polylines B.

●     if you fill a closed area A, the imaginary line between the intersection points of 
the inclination lines B with the area must not intersect the area A.

   dashed line intersects      dashed line does not intersect
             not OK!                              OK!
 



If you use guide lines, the following rules must be respected:

●     The guide lines must be designed in the same direction as you select the 
inclination polylines B.

●     The vertices of the inclination polylines must be exactly on the guide line C.

●     If you select the guide lines C, you must select them in the same direction as the 
inclination polylines B were designed.

To fill an area with polyarcs with random ray length you can proceed as 
follows...

Command: ARCFILL
Select boundary edge 1/<Parameter>: <Ret>

>> Define Random=70 in the menu << 

Select boundary edge 1/<Parameter>: P1
Select boundary edge 2: P2
Select inclination lines...
Select entities: P3
Select entities: P4
Select entities: <Ret>



AREAFILL - How to fill an area with color 

Toolbar: Fill > Solid filled area  

Menu:  Sketch > Solid filled area

Keyboard:  AREAFILL

This command is also used to fill an area with a solid color. 

After calling up the command, you can choose a point within an area, where you 
want a border to be constructed. You can fill areas until you terminate the command 
with <Ret>.

Command: AREAFILL
Boundary/<Point in area>: Point in area
Boundary/<Point in area>: <Ret>  

If the design is getting bigger it can take long time to find the boundary. In this case 
you can use the Boundary option to select the elements, which are recognized for 
the boundary calculation. 

 
Command: AREAFILL
Boundary/<Point in area>: B
Select boundary edge (s)...
Select entities: select boundary 1
...
Select entities: select boundary x
Select entities: <Ret>
Boundary/<Point in area>: Point in area
Boundary/<Point in area>: <Ret>  

The resulting solid fill will be placed on layer 1, the area boundery in layer 3.

Attention! If the fill should be successful, the selected area 
must be closed! 



BORDER - How to design a polyline around an 
area 

Toolbar: Fill > Area boundary 

Menu:  Construct > Area boundary...

Keyboard:  BORDER

This command is used to create a closed border. After calling up the command a 
menu is opened.

In the menu you can choose from the following options...

Select boundary
With this option you can manually create a closed area.

First select the elements, which are necessary to create the desired area. The 
selected elements are copied to the layer AMD_BORDER  and all other layers are 
switched off, so that you can see only the which are necessary for the construction 
of the boundary.

Now you can use the normal trimming commands like JOIN , TRIM  etc. to 
construct the desired area.

Finally you can use the command TOVIEW  to switch back to the normal work 
view.



The resulting polyline will be placed on the layer AMD_BORDER. It can be erased 
with the option Delete.

Find boundary
After calling up this option, you can choose a point within an area, where you want a 
border to be constructed. 

Boundary/<Point in area>: P1 

If the design is getting bigger it can take long time to find the boundary. In this case 
you can use the Boundary option to select the elements, which are recognized for 
the boundary calculation. 

Boundary/<Point in area>: B
Select boundary edge (s)...
Select entities: select P1
Select entities: select P2
Select entities: select P3
Select entities: <Ret>
Boundary/<Point in area>: P4

The resulting polyline will be placed on the layer AMD_BORDER. It can be erased 
with the option Delete.

Attention: If the search for boundary edges should be 
successful, the selected area must be closed! 

Delete



With this option you can erases borders constructed with the previous options.

Done
Terminate the command



CHAIN2P - How to arrange 2 point blocks 

Toolbar:  Construct > 2 point chain 

Menu:  Construct > 2 point chain

Keyboard: CHAIN2P 

Blocks, which are defined with 2 points (i.e. arches, pointed arches, dots etc.) can be 
arranged along a guide line with this command, whereby either the quantity of 
elements or the size of elements must be selected.
First select a guide line, along which the blocks must be arranged.  Then a menu 
with predefined blocks will appear. Select the desired block, and finally you may 
define the quantity of the blocks and the block size. 

Command: CHAIN2P

 
Select guide line (s) ...
Select entities: P1
Select entities: <Ret>
Number of items <0>: 5
Size of block <0.00> : <RET>

If you define Number of items = 0, you may define the block size and the distance 
between the blocks. The quantity of the blocks will then be calculated based on this 



size of the block and the length of the guideline. 
Command: CHAIN2P

>> Block dialog-box <<

Select guide line(s) ...
Select entities: P1
Select entities: <Ret>
Number of items <0>: <Ret>
Size of block <1.00>: 5
Distance between blocks <0.00>: <Ret>

 

Attention: To get a correct result, the blocks must be 
standardized on 1 mm. (see blocks) 



CHAINC - How to arrange center blocks 

Toolbar:  Construct > Center chain 

Menu:  Construct > Center chain

Keyboard: CHAINC 

Blocks, which are defined by their center (i.e. circles, stars, asterix etc.) can be 
arranged along a guide line, whereby you can select the quantity or the size of the 
elements.
First select the guide line, along which the blocks must be arranged. Then a menu 
with predefined blocks will appear. Select the desired block. 
Now you may define the quantity of blocks and the block size. If no block size is 
defined, a chain of blocks will be constructed without distance between the blocks. 

Command: CHAINC

Select guide line(s) ...
Select entities: P1
Select entities: <Ret>
Number of items <0>: 4
Size of block <1.00>: 3

 

If you define Number of items = 0, you may define the block size and the distance 



between the blocks. The quantity of the blocks will then be calculated based on this 
size of the block and the length of the guideline. 

Command: CHAINC

>> Block dialog-box <<

Select guide line(s) ...
Select entities: P1
Select entities: <Ret>
Number of items <0>: <Ret>
Size of block size <1.00>: 3
Distance between blocks <0.00>: 3.5

 

Attention: To get a correct result, the blocks must be 
standardized on 1 mm. (see blocks) 



MODULE - How to work with modules

Toolbar: Construct > Module 

Menu: Construct > Module

Keyboard: MODULE 

A module is a pattern of stitches, which can be recorded under a certain name and 
arranged along a polyline (running stitch). 

See more...

 How to use modules



MANSTI - How to design single stitches 

Menu:  Construct > Manual stitches

Keyboard: MANSTI 

With this function you may design stitches or inclination lines. 

First select the boundary edges, where the stitches must be cut, next design the 
stitches or inclination lines, finally the stitches will be cut at the selected boundary 
edges. 

Attention: Design the stitches in a way that the stitches 
intersect the boundary  edges at both ends. 

Command: MANSTI
Select boundary edge(s) ...
Select entities: select
Select entities: <Ret>
Direction of stitches...
From point: P1
To point: P2
...
From point: P5
To point: P6
From point: <Ret> 

All stitches or inclinations are saved on the layer AMD_BLATTSTITCHES. 



How to work with blocks

Block commands can be called up from the Construct toolbar. 

A block is a set of lines, arcs, circles etc. which are joined to form a complex object. 
This group of elements will be given a block name. A block can be recalled at any 
time, at any place, in any size and under any angle and inserted into the design. A 
block will be handled as a single object, it can be displaced, copied, deleted etc. It 
makes sense to create and memorize blocks of often used elements such as leaves, 
flowers, stars etc. These blocks can later be recalled and inserted in any desired 
design. 

 
There are three types of blocks: 

●     Blocks, delivered with the system. These blocks are filed in the subdirectory: 
C:\ICAD\BIB\S (S for system) and the file name of these blocks starts with 
AMD. 

●     Blocks created by the operator and filed on hard disk. These blocks are filed in 
the subdirectory: C:\ICAD\BIB\U (U for user). The block name may not start 
with AMD. 

●     Blocks created by the operator, however only used with the actual design. These 
blocks may not be filed on the hard disk. 

The subdirectory is being defined using the system variable AMD_BIB. In the 
library subdirectory the directories U, S, SLD and DATA are located. This system 
variable can be initialized in the file EDS.INI. 

AMD_BIB=C:\ICAD\BIB 

Attention: When inserting filed blocks you have to define an 
enlargement factor. This enlargement factor is based on the 
original size of the block. If a block in original has a size of i.e. 
6 mm and you define a factor 3, the inserted block will have a 
size of 18 mm. For this reason all blocks should be filed with 
the size 1 mm. In this case the enlargement factor will 
correspond to the real size. With the  LIBMAN command 
you may create blocks, which are normalized on 1 mm. 

Liza
Comment on Text
Как работать с блоками
Block commands can be called up from the Construct toolbar.
A block is a set of lines, arcs, circles etc. which are joined to form a complex object.
This group of elements will be given a block name. A block can be recalled at any
time, at any place, in any size and under any angle and inserted into the design. A
block will be handled as a single object, it can be displaced, copied, deleted etc. It
makes sense to create and memorize blocks of often used elements such as leaves,
flowers, stars etc. These blocks can later be recalled and inserted in any desired
design.



The Block Toolbar is a flyout of the Construct Toolbar and contains the following 
commands...
 
 Block Toolbar 

LIBMAN - How to use the library manager 

INSERT - How to insert blocks by name 

DEFBLOCK - How to define a new block 

PAILLETT - How to insert paillettes 

BLOCKNR - How to count number of blocks 



LIBMAN - How to use the library manager 

Toolbar: Block > Librarian  

Menu:  Construct > Blocks > Librarian...

Keyboard:  LIBMAN

With this command you can insert blocks from an icon-menu.

Icon menus are divided into libraries. The library can be selected from the popup list 
below the symbol list. Libraries can be added by editing the SYMLIB.CSV file in the 
DATA directory.

The symbols can be selected by picking an icon or by selecting the symbol 
description in the symbol list. If there are more than 12 symbols within one library, 
you can go to the next or to the previous page by picking one of the arrow buttons.

If you activate the Insert field, the selected symbol can be inserted in the drawing 
as often as you need it. When you are ready with inserting you can use <Ret> to 
come back to the dialog-box.

Add - How to add a symbol to the library
Via the button Add you can create a new block and add it to the icon menu. The 
new block is inserted at the position of the actually selected symbol.

First, as in the standard block definition, you have to specify a block name and the 
insertion point. Then you can define the description, displayed in the dialog-box.

If you want to use the block with the command  CHAIN2P and  CHAINC, the 
reference length must be defined. The Reference length corresponds to the width of 
the object in X direction.

Finally you must select the elements joint in the block.



To redefine an existing block named FL1 with its original size you can proceed as 
follows...

Block name: FL1
Block FL1 already exists.

Description: Flower 7 paddles
Insertion point: P1

Select entities: P2
Select entities: P3
Select entities: <Ret>

To redefine an existing block named FL1 as standard block with 1mm size you can 
proceed as follows...

Block name: FL1
Block FL1 already exists.



Description: Flower 7 paddles
Insertion point: P1

Reference length: P2
Second point: P3
Select entities: P4
Select entities: P5
Select entities: <Ret>

Attention: If a block already exists, you will be asked, if you 
really want to overwrite the existing block. If you overwrite the 
block, the existing block in the library will be changed and the 
new block will be inserted at the desired position.

 

Attention: When you create a block, the actual view on the 
screen will be displayed in the slide of the icon menu. 
Therefore it is important, that you display the block as big as 
possible, before you create a block.

Remove - How to remove a symbol from the library
Via the button Remove you can remove the selected symbol from the library. On 
deletion of the block, the slide as well as the entry in the icon-menu will be erased.

Before the symbol will be erased, you will be asked, if you really want to erase it.

 



INSERT - How to insert blocks by name 

Toolbar: Block > Insert by name  

Menu:  Construct > Blocks > Insert by name

Keyboard:  INSERT

With the command INSERT you may insert blocks from the library. 

After calling up this command, you must  first enter a block name. Your next step is 
to determine the  insert point. This point corresponds with the base point of the 
block. Finally you have to define the scale factor and the insertion angle. 

To insert a block named flower1 with scale factor 10 and rotation angle 0 proceed 
as follows:

Command: INSERT
Block name <last>: flower1
Insertion point: base point of block
Scale factor <1>: 10
Rotation angle <0>: <Ret> 

Note: If * is being placed ahead of the block name, the block 
will directly be exploded upon insertion. 

 



DEFBLOCK - How to define a new block  

Toolbar: Block > Define block  

Menu:  Construct > Blocks > Define block

Keyboard:  DEFBLOCK

With the command DEFBLOCK you can create a block definition, this means, you 
combine parts of an existing design to blocks. 

First you define a block name which can have up to 8 characters (characters, 
numbers as well as “_” and “-”). If you have already used the name for another 
block the system will ask you if you want to redefine this block. If you answer the 
question with yes, blocks, already inserted in the design, will be replaced with the 
new block. 

After you have defined the block name you have to specify the base point. This is 
the point, on which the block has to be inserted into the design. Around this point 
the block can also be rotated on insertion. 

The elements, which form the block, can be determined with the usual object 
selection methods. 

To redefine an existing block named FL1 with its original size you can proceed as 
follows...

Command: DEFBLOCK
Block name: FL1
Block FL1 already exists.

Insertion point: P1
Select entities: P2



Select entities: P3
Select entities: <Ret>

DEFBLOCK also allows for simple definition of standard blocks (blocks with 1 mm 
size) used with the command  CHAIN2P and  CHAINC.
After the definition of the insert point, a reference length must be defined. The 
Reference length corresponds with the width of the object in horizontal direction. 

To redefine an existing block named FL1 as standard block with 1mm size you can 
proceed as follows...

Command: DEFBLOCK
Block name: FL1
Block FL1 already exists.

Reference length: P2
Second point: P3
Insertion point: P1
Select entities: P4
Select entities: P5
Select entities: <Ret>



PAILLET - How to insert paillettes  

Toolbar: Block > Paillettes  

Menu:  Enlarge > Paillettes...

Keyboard:  PAILLET

With this command you can insert paillettes from an icon-menu.

The paillettes can be selected by picking an icon or by selecting the symbol 
description in the symbol list. If there are more than 12 symbols within one library, 
you can go to the next or to the previous page by picking one of the arrow buttons.

If you activate the Insert > field, the selected paillette can be inserted manually or 
it can be distributed along a polyline.

Distribute paillettes along a polyline
To insert paillettes along a polyline just select one or more polylines, along which the 
paillettes should be distributed, and then specify how many paillettes you want to 
have inserted on a single polyline.

To arrange 7 paillettes along a polyline you can proceed as follows...

Select entities: P1
Select entities: <Ret>
Number of items <0>: 7

You can also specify the distance between the paillettes. In this case the system 
calculates the quantity for you. To specify the distance confirm the request for 
number of items with <Ret>, then you can specify the distance between the 
paillettes.

To arrange paillettes with a distance A along a polyline you can proceed as follows...

Select entities: P1
Select entities: <Ret>
Number of items <0>: <Ret>



Distance between block <last>: specify distance A

Insert paillettes manually
To insert paillettes manually just click <Ret> instead of selecting polylines. Now the 
paillette hangs at your cross-hair and you can insert as many paillettes as you need 
it. When you are ready with inserting you can use <Ret> to come back to the 
dialog-box.

Select entities: <Ret>
Insertion point: center of paillette 1
....
Insertion point: center of paillette x
Insertion point: <Ret>

‘Add’ field - Add a paillette to the library

Via the button Add you can create a new paillette and add it to the icon menu. The 
new paillette is inserted at the position of the actually selected paillette.

First, as in the standard block definition, you have to specify a name and the base 
point. Then you can define the description, which is displayed in the dialog-box. 
Finally select the elements joint in the block.

To add a paillette with the name PA5 and description 5mm proceed as follows...

Block name: PA5
Insertion point: P1
Description: 5mm
Select entities: P2
Select entities: P3
Select entities: <Ret> 

Attention: If a paillette already exists, you will be asked, if 
you really want to overwrite the existing one. If you overwrite 
the paillette, the existing block in the library will be changed 
and the new block will be inserted at the desired position.

 



Attention: When you create a paillette, the actual view on the 
screen will be displayed in the slide of the icon menu. 
Therefore it is important, that you display the block as big as 
possible, before you create the paillette.

‘Removel’ field - Remove a symbol from a library

Via the button Remove you can remove the selected paillette from the library. On 
deletion of the paillette, the slide as well as the entry in the icon-menu will be 
erased.

Before the paillette will be erased, you will be asked, if you really want to erase it.

 



BLOCKNR - How to count number of blocks 

Toolbar: Block > Count blocks  

Menu:  Construct > Blocks > Count blocks

Keyboard:  BLOCKNR

The command BLOCKNR allows you to find out, how many blocks with a certain 
name are inserted in a design. This can be used to count e.g. pailettes. 

Command: BLOCKNR
Select block: Select block to be counted



DDINSERT - How to insert other blocks  

Toolbar: -

Menu:  Construct > Blocks > Insert...

Keyboard:  DDINSERT

The command DDINSERT is the universal command to insert a block. This 
command allows you to insert any block, filed in any directory. 

This command makes sense, when a complete design has to be inserted in the 
actual design, or if you want to insert a block with different XY factors. 

After calling up the command, a dialog-box appears, where you can choose the 
desired block. 

Command: DDINSERT

>>> Dialog-box <<<

Insertion point of block: insertion point
Corner/XYZ/X-scale factor <1>: <Ret>
Y-scale factor<Equal to X scale=(1)>: 2
Rotating angle for block <0>: <Ret> 

Note: If you activate the option Explode block within the 
dialog-box, the block will be exploded directly on insertion. 

 



Note: With this command, blocks with different XY factors can 
also be inserted. This can be used to scale a complete design in 
perceptually in one direction. 

 

Attention: Blocks with different X and Y factors cannot be 
exploded with the command EXPLODE. 



System settings

In this chapter we talk about various system settings. All setting functions are 
located in the Toolbar Object properties or in the pull down menu Modes.

The Object properties Toolbar contains the following commands...
 
 Object properties Toolbar 

DDLMODES - How to manage layers 

TOVIEW - How to switch layer groups 

LSET - How to activate layers

LON - How to switch layers on/off 

LX - How to change the layer of an element 

Flyout Object Snap (See chapter 1) 

Other settings in the pull down menu

The following commands cannot be selected from a toolbar. They must be called up 
from the pull down menu.

 DDRMODES - How to adjust settings of drawing aids

 DDGRIPS - How to adjust grips

 DDSELECT - How to adjust entity selection

 DDOSNAP - How to adjust entity snap

 SETDEF - How to save and load embroidery parameters

 TABLET - How to configure the digitizer command and screen area



Layer administration 

Parts of a design can be laid on different layers. The layers AMD_WORK, 
AMD_BORDER, AMD_AUXLIN and the layers 5 to 99 are available for the user. 
All other layers are automatically managed by the system.



DDLMODES - How to manage layers 

Toolbar: Object properties > Layers 

Menu:  Modes > Layer > Layer

Keyboard: DDLMODES

With DDLMODES a dialog-box is activated, which will give you control of all layers. 

You can...

●     activate a layer by double clicking on the desired layer name. The active layer has 
a tick left from the layer name.

●     create new layers with Edit > New > Layer

●     delete a layer with all elements, laying on the layer, with Edit > Delete

●     rename a layer with Edit > Rename

●     changing the color of a layer by clicking on the color rectangle in the Color 
column and choosing a new color from the upcoming dialog-box.

●     switching On/Off a layer by clicking on the On or Off in the On/Off column.

●     locking or unlocking a layer by clicking on the No or Yes in the Locked column.

Attention: Only change settings of your own layers. Do not 
change layer names or layer settings of layers, managed by the 
system! System layers start with the characters AMD_. Also 
the layers 0 - 9 are system layers



 
Hint: If you should work on a light image, it can be very 
difficult to see the white tracing line when you are taking over 
the image. To change the tracing color click on the color 
rectangle right from the layer AMD_WORK and choose 
another color from the color dialog-box.



TOVIEW - How to switch layer groups 

Toolbar: Object properties > Layer group 

Menu: Modes > Layer > Layer group

Keyboard: TOVIEW 

The command TOVIEW makes layer groups visible or invisible, depending on the 
job to be carried out.
After calling up the command a menu opens, where you can select the layer group, 
which you want to have activated.

In the parameter menu you can choose from the following options...

Sketch
All layers, necessary for the output of a 1:1 sketch, are activated. Stitches and other 
elements of an enlargement are not visible. 

 

Enlargement 
All layers, necessary for the output of a correct enlargement, will be activated. 
Inclination lines, infolines etc. are not visible. 



 

Punch
Only the layers with the infolines, which represent the punch stitches, plus the 
repeat and the header are activated. 

 

Work
Layers, necessary to work on an enlargement, are activated. Infolines, inclination 
lines and all automatically created embroidery elements are included in the group. 

 



LSET - How to activate layers  

Toolbar: Object properties > Layer Set 

Menu: Modes > Layer > Layer Set

Keyboard: LSET 

A layer is defined as active, when new design elements are filed on it. After calling 
up the command LSET a menu is displayed, where you can choose the layer, which 
you want to activate.

By choosing the option Set from element you can taken over the layer, which you 
want to activate, from an element in your design. 

Select element on desired layer: select item

 



LON - How to switch layers on/off

Toolbar: Object properties > Layer On/Off 

Menu: Modes > Layer > Layer On/Off

Keyboard: LON 

Elements on a layer can be visible (On) or invisible (Off). Only Elements on visible 
Layers can be displayed on the screen or can be plotted. 

After calling up the command a menu is displayed, where you can see the status of 
certain layers. Layers with a << behind their name are actually switched on, layers 
without << are switched off. By clicking the desired layer you can change the status 
of the layer from on to off or from off to on.

By choosing the option All layers on you can switch on all layers in the actual 
design and hence make visible all elements of the design.



LX - How to change the layer of an element

Toolbar: Object properties > Change layer 

Menu: Edit > Change > Change layer

Keyboard: LX 

With the command LX you can change the layer of selected elements. There are 
three ways to change the layer. The new layer can be the actual layer, the layer, 
another element belongs to, or the layer, selected from a dialog-box.

Actual

With the option Actual the selected elements will be placed on the actual layer.
Command: LX
Select entities: selection
Select entities: <Ret>
Actual / From element/ From List: select Actual

From element

With the option From element you can move the selected elements to the layer, 
which a picked element belongs to.

First you have to select the elements you want to change, then you have to pick an 
element, that belongs to the desired layer.

Command: LX
Select entities: selection
Select entities: <Ret>
Actual / From element/ From List: select From element
Element on desired layer: pick element

From List

You can also define the desired layer by selecting it from a dialog-box. First you have 
to select the elements, which you want to have changed, then you have to select the 
destination layer from a dialog-box.

Command: LX
Select entities: selection
Select entities: <Ret>
Actual / From element/ From List: select From List



 



DDRMODES - How to adjust settings of drawing 
aids 

Menu: Modes / Drawing aids ...

Keyboard: DDRMODES 

Using DDRMODES a dialog-box will be activated, which allows to control the 
drawing aids.

The following drawing aids can be controlled:

●     Grid For easier positioning of design elements, you can define a visible point grid. 
The grid is only a designing aid and is no part of the design itself. The grid 
distance can be controlled and the grid itself can be switched on and off.

●     Snap With the snap function you can define an invisible grid. With the cross hair 
you can only snap points on the grid. The distance of these grid points can again 
be defined and the snap mode can be switched on and off.

●     Orthogonal The orthogonal mode allows for absolute vertical and horizontal 
designing independent from the input with the design device. This option can be 
switched on and off.

 



DDGRIPS - How to adjust grips 

Menu: Modes / Grips...

Keyboard: DDGRIPS

Selected entities can be edited using the handles, which appear on the definition 
points of the object. The dialog-box DDGRIPS allows for modification of handle 
parameters, such as color and size of the handle.

DDSELECT - How to adjust entity selection
[ Modes / Entity selection ... ] - If you want to modify elements you must first select 
them. Using the dialog-box DDSELECT you can set object selection parameters, such 
as size of the pick box.

TABLET - How to configure the digitizer command and screen area
[ Modes / Tablet ] - With this command, you can align the digitizer overlay.

After calling up the command a popup menu with options is displayed. Enter CFG by 
keyboard to start the configuration. Now you are asked, if you want to align the 
overlay. Answer with Yes. Finally you must pick the 5 points shown below in the 
correct order.

Command: TABLET
Command: TABLET



Tablet: ON/OFF/CALibrate/ConFiGure/<On>: CFG
Do you want to align the tablet overlay? Yes/No/<No>: Y
Digitize upper left corner of overlay: P1
Digitize lower left corner of overlay: P2
Digitize lower right corner of overlay: P3
Digitize lower left corner of screen pointing area: P4
Digitize upper right corner of screen pointing area: P5



DDSELECT - How to adjust entity selection

Menu: Modes / Entity selection ...

Keyboard: DDSELECT

If you want to modify elements you must first select them. Using the dialog-box 
DDSELECT you can set object selection parameters, such as size of the pick box.



DDOSNAP - How to adjust entity snap

Menu: Modes / Entity snap ...

Keyboard: DDOSNAP

One or more entity snap methods can be switched on permanently. In this dialog-
box you can control the use of entity snap methods.

Note: To switch off all entity snap methods you can also use 
the menu function Modes > Clear entity snap.



SETDEF - How to save and load embroidery 
parameters

Menu: Modes / Embroidery defaults

Keyboard: SETDEF

With this command, you can save, load and reset the parameters of all automatic 
stitches. So you can define settings for different kind of fabrics and yarns and recall 
these settings whenever you need them again.

After calling up the command a menu is opened.

In the menu you can choose from the following options...

Save to file
With this option you can save all parameters of the various automatic stitches in a 
file. After choosing this option the file dialog-box opens where you can specify the 
file name and the place where you want to save the parameters. 

Read from file
With this option you can initialize all parameters of the various automatic stitches 
from a previously written file. After choosing this option the file dialog-box opens 
where choose the desired parameter file. 

Set default
Sets the parameters of all automatic stitches to the system default value. 



TABLET - How to configure the digitizer command 
and screen area

Menu: Modes / Tablet

Keyboard: TABLET

With this command, you can align the digitizer overlay.

After calling up the command a popup menu with options is displayed. Enter CFG by 
keyboard to start the configuration.
Next you are asked, if you want to align the overlay. Answer with Yes.
Finally you must pick the 5 points shown below in the correct order.

Command: TABLET
Tablet: ON/OFF/CALibrate/ConFiGure/<On>: CFG
Do you want to align the tablet overlay? Yes/No/<No>: Y
Digitize upper left corner of overlay: P1
Digitize lower left corner of overlay: P2
Digitize lower right corner of overlay: P3
Digitize lower left corner of screen pointing area: P4
Digitize upper right corner of screen pointing area: P5



Automatic embroidery functions 

This program allows for construction of embroidery elements automatically as 
technical enlargements. The exact number of turns can be determined for elements, 
which are designed in this way and you can use ProLace to directly take over these 
elements.

How to enlargement with automatic functions

If you want to make an enlargement with basic elements, such as lines, polyarcs, 
polylines and circles as follows:

●     Select the desired automatic functions from the embroidery toolbox or from the 
pull-down menu. You now will be asked to select the guide line or to input a 
point.

●     Before the selection or before entering the first point you can call up the menu to 
specify the embroidery parameters. This can be done by clicking the right mouse 
button.
Set the embroidery parameters, such as raedle, color, density, etc.

Note: Length values have to be defined in mm, scale 1:1.

●     After having specified all the parameters, you can leave the menu via the Done 
option.

●     Now you can continue with the next steps. In the following section you will find 
the explanation for each single function.

Attention: Automatic effects can only be used on polylines 
and circles. 

The Embroidery Toolbar contains the following commands...
 

Embroidery Toolbar 

Flyout Edge 

Flyout Blattstitch 

STAR - How to design star dots 

Flyout Geflect 

Flyout Boring 

Flyout Borer holes

ZUCHOLE - How to construct zucholes 

PICO - How to design lock stitches 



UNDER - How to add underlayers

Flyout Macros 

Flyout Modify 

DELEMB - How to delete embroidery objects 

Edge Toolbar 

SEDGE - How to design a single edge 

DEDGE - How to design a double edge 

CEDGE - Hesign a circular single edge 

WIGGLE - How to design wiggle stitches 

Blattstitch Toolbar 

BLATTSTI - How to design a rotated blattstitch 

DBLATT - How to construct a divided blattstitch

CIRBLATT - Circular blattstitch with hole 

DOT - How to design blattstitch dots 

BORPAD - How to apply a bored paddle 

Geflect Toolbar 

GEFLECT - How to construct a rotated geflect 

CGEFLECT - How to fill an area with curves 

PGEFLECT - How to construct a parallel geflect 

STEP - How to design step stitches 

Boring Toolbar 

HOEHL - How to construct holes 

POINT - How to add boring points 

STEFFEL - How to design a steffel 

Borer holes Toolbar 

GBORER - How to embroider round a hole with an 
irregular shape

CBORER - How to embroider round a circular hole

RBORER - How to embroider round a rectangular hole

EBORER - How to embroider round an elliptical hole

DBORER - How to embroider round hole like a drop



Embroidery macros Toolbar 

MFLOWER - How to construct a flower 

MBORDER - How to construct a border 

Modify embroidery objects Toolbar 

MODIFY - How to modify embroidery effects 

UPDATE - How to update stitches of  effects 

DENSITY - How to modify the density of embroidery 
objects 



SEDGE - How to design a single edge  

Toolbar: Edge > Single edge 

Menu:  Enlarge > Edge > Single edge

Keyboard: SEDGE

With the command SEDGE single edges can be automatically constructed by picking 
the guide line. The guide line represents the center of the edge. 

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button.

Command: SEDGE
Select guide lines/<Parameters>...
Select entities: <Ret>

The following parameters can be defined....

Menu entry Description

Stitches If Yes, all stitches will be designed for the 
technical enlargement.
If No, only corner stitches will be designed

Color Display color for the enlargement.
Attention: This color setting has no 
influence on punching!

Raedle You can select the desired Raedle from a 
menu. If you change the Raedle, also the 
Density will be adjusted according this 
value.

Density Stitch distance A in millimeter

Width Edge with B in millimeter

Done Exit from the menu and continue with 
selecting guide lines.

Cancel Interrupt the command

 

If the parameters are defined correctly, select all guide lines and finally the effect is 
constructed by the system. 

To arrange an edge on a guide line you can proceed as follows...



    
Command: SEDGE
Select guide lines/<Parameters>...
Select entities: P1
Select entities: <Ret> 

Attention: If a corner of the guide line is too accurate, the 
system might not be capable to construct a parallel line of  the 
edge.

Attention: The guide line must not be closed!

 



CEDGE - How to design a circular single edge  

Toolbar: Edge > Circular edge 

Menu:  Enlarge > Edge > Circular edge

Keyboard: CEDGE

With the command CEDGE circular single edges can be automatically constructed by 
defining the center and the radius. The given radius represents the radius of the 
center line of the edge.

The position, where you click the radius, is the position, where the edge starts. The 
start is marked with a small red cross. If you realize on punching, that the start is at 
the wrong position, you can use the  ROTATE command to rotate the element.

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button. 

Command: CEDGE
Center point/<Parameters>: <Ret> 

The following parameters can be defined...

Menu entry Description

Stitches If Yes, all stitches will be designed for the 
technical enlargement.
If No, only corner stitches will be designed

Color Display color for the enlargement.
Attention: This color setting has no 
influence on punching!

Raedle You can select the desired Raedle from a 
menu. If you change the Raedle, also the 
Density will be adjusted according this 
value.

Density Stitch distance A in millimeter

Width Edge with B in millimeter

Done Exit from the menu and continue with the 
definition of the center.

Cancel Interrupt the command

 

If the parameters are defined correctly, select all guide lines and finally the effect is 
constructed by the system. 

If you want to terminate the command press the right mouse button and use the 
Cancel option of the upcoming menu. 



To construct a circular edge you can proceed as follows...

Command: CEDGE
Center point/<Parameters>: P1
Radius<actual value>: P2
Center point/<Parameters>: <Ret>



DEDGE - How to design a double edge  

Toolbar: Edge > Double edge 

Menu:  Enlarge > Edge > Double edge

Keyboard: DEDGE

With the command DEDGE double edges can be automatically constructed by 
picking the guide line. The guide line represents the center of the edge. 

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button.

Command: DEDGE
Select guide lines/<Parameters>...
Select entities: <Ret> 

The following parameters can be defined...

Menu entry Description

Stitches If Yes, all stitches will be designed for the 
technical enlargement.
If No, only corner stitches will be designed

Color Display color for the enlargement.
Attention: This color setting has no 
influence on punching!

Raedle You can select the desired Raedle from a 
menu. If you change the Raedle, also the 
Density will be adjusted according this 
value.

Density Stitch distance A in millimeter

Width Edge with B in millimeter

Done Exit from the menu and continue with 
selecting guide lines.

Cancel Interrupt the command

 

If the parameters are defined correctly, select all guide lines and finally the effect is 
constructed by the system. 

To arrange a double edge on a guide line you can proceed as follows...



Command: DEDGE
Select guide lines/<Parameters>...
Select entities: P1
Select entities: <Ret> 

Attention: If a corner of the guide line is too accurate, the 
system might not be capable to construct a parallel line of  the 
edge.

Attention: The guide line must not be closed!

 



WIGGLE - How to design wiggle stitches 

Toolbar: Edge > Wiggle stitch 

Menu:  Enlarge > Edge > Wiggle stitch

Keyboard: WIGGLE

With the function WIGGLE wiggle stitch can be designed  along guide lines. 

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button.

Command: WIGGLE
Select guide lines/<Parameters>...
Select entities: <Ret>

The following parameters can be defined...

Menu entry Description

Color Display color for the enlargement.
Attention: This color setting has no 
influence on punching!

Raedle You can select the desired Raedle from a 
menu. If you change the Raedle, also the 
Density will be adjusted according this 
value.

Density Stitch distance A in millimeter

Width Wiggle width B in millimeter

Done Exit from the menu and continue with 
selecting guide lines.

Cancel Interrupt the command

 

If the parameters are defined correctly, you can continue with the selection of guide 
lines. If you have drawn the guide lines with a filling function like  PATFILL, you 
can use the entity selection option Previous to select all elements of the effect.
Finally the effect is constructed by the system.

To arrange wiggle stitches on guide lines you can proceed as follows...

Command: WIGGLE
Select guide lines/<Parameters>...
Select entities: P1



Select entities: <Ret> 

 



BLATTSTI - How to design a rotated blattstitch  

Toolbar: Blattstitch > Rotated blattstitch 

Menu:  Enlarge > Blattstitch > Rotated blattstitch

Keyboard: BLATTSTI

With this command you can fill any area with a blattstitch. The area can be 
represented by a single closed polyline or by a circle, or it can be represented by two 
polylines. In case of two polylines, the area must be between the two polylines (see 
below). 

Hint: If the boundary of a blattstitch is made up of more then 
two polylines, you can use the command  BORDER to 
generate a single polyline, which is surrounding the desired 
area.

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button.

Command: BLATTSTI
Select boundary edge 1/<Parameter>: <Ret> 

The following parameters can be defined...

Menu 
entry Description

Stitches If Yes, all stitches will be designed for the technical 
enlargement.
If No, only stitches at the inclination lines will be 
designed

Color Display color for the enlargement.
Attention: This color setting has no influence on 
punching!

Raedle You can select the desired Raedle from a menu. If 
you change the Raedle, also the Density will be 
adjusted according this value.

Density Stitch distance A in millimeter



Transition With the transition option you can define variable 
densities for a single object.

             Off                         Random            
0.3>0.9>0.3

See also...

 How to define the transition parameters

Define 
pattern...

Define how the system generates the stitch pattern. 

See also...

 How to define the stitch pattern

Random The rays of the effect have a  random length. The 
random part can be Inside, Outside or on both sides.

See also...

 How to define a random pattern

Over Here you can specify how many percent of the total 
stitch length the system sticks behind the boundary. 

After clicking this option you can define the 
overstitch value in %. 
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Density 
correction

If the blattstitch is getting too narrow, the stitch 
distance should be increased up to the double value 
of the regular blattstitch distance. 

After clicking this option you can define the low 
value L and the high value H to define the section S, 
between which the system corrects from normal 
stitch distance to double stitch distance.

Shorten 
stitches

To prevent, that stitches are getting too dense, 
stitches can be moved to the inner side by a certain 
value. 

After clicking this option you can first define the 
minimum stitch distance A and then the distance B, 
by which stitches should be moved.
If the density is getting smaller than the defined 
distance, the system starts to move stitches by the 
defined value.

Done Exit from the menu and continue with selecting 
boundaries.

Cancel Interrupt the command

If the parameters are defined correctly select first the blattstitch boundaries. 
Thereafter define the inclination lines, whereby the inclination lines must cross the 
blattstitch boundary lines.
Important! The starting point of the first inclination line specifies the side, on which 
the blattstitch starts. The endpoint of the last inclination line defines the side, on 
which the blattstitch ends.

See also...

 How to define the transition parameters

 How to define the stitch pattern
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 How to define a random pattern

 How to define inclination lines

Finally, after having constructed all inclination lines and after having left the 
inclination line menu with the Build option,  the effect is constructed by the system. 

To fill an area with a blattstitch you can proceed as follows...

Command: BLATTSTI
Select boundary edge 1/<Parameter>: P1
Select boundary edge 2: P2
Direction of stitches...
From point/<Parameter>: P3
To point: P4
Direction of stitches...
....
To point: P10
Direction of stitches...
From point: <Ret>
>> Select Build from the menu << 

Note: If the system hangs because of incorrectly defined 
inclination lines, the calculation can be interrupted by pressing 
ESC one or more times. 
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DBLATT - How to construct a divided blattstitch   

Toolbar: Cgeflect > Divided blattstitch 

Menu:  Enlarge > Blattstitches > Divided blattstitch

Keyboard: DBLATT 

With the command DBLATT you can construct a divided blattstitch.  

The area can be represented by a single closed polyline or by a circle, or it can be 
represented by two polylines. In case of two polylines, the area must be between 
the two polylines (see below). 

Hint: If the boundary of a blattstitch is made up of more then 
two polylines, you can use the command  BORDER to 
generate a single polyline, which is surrounding the desired 
area.

Before you can fill the area you must construct the inclination polylines.

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button.

Command: DBLATT
Select boundary edge 1/<Parameter>: <Ret> 

The following parameters can be defined...

Menu entry Description

Stitches If Yes, all stitches will be designed for the 
technical enlargement.
If No, only stitches at the inclination lines will 
be designed

Color Display color for the enlargement.
Attention: This color setting has no 
influence on punching!

Raedle You can select the desired Raedle from a 
menu. If you change the Raedle, also the 
Density will be adjusted according this 
value.

Density Geflect density A in millimeter



Stitch length If the Stitch length B is unequal to 0, the 
system divides the stitchs in a way that the 
stitches have approximately the specified 
length.

The stitches are distributed unequally. To get 
this uneven distribution, the first stitch has a 
random length. The length is between the 
Minimum stitch length and the Stitch 
length. The bigger the difference between 
this two values is, the more uneven the 
pattern will be.

Minimum 
stitch length

If the stitch is being divided by one of the 
following methods, this value defines the 
minimum stitch length the system allows. 

Guide line(s) With additional guide lines you can get a 
smoother distribution of the arcs. The guide 
lines must also be constructed before you can 
call up the command.

Done Exit from the menu and continue with 
selecting boundaries.

Cancel Interrupt the command

 
If the parameters are defined correctly, select first the blattstitch boundaries. 
Thereafter select the previously designed inclination polylines.

Important! The starting point of the first inclination line specifies the side, on which 
the blattstitch starts.

To construct a divided blattstitch, the following rules must be respected:

●     All inclination polylines B must be designed in the same direction.

●     All inclination polylines B must be designed with the same number or line 
respectively arc segments.

●     The inclination polylines must not have curve segments.

●     The inclination polylines B must be selected in the proper order.

If you use guide lines, the following rules must be respected:



●     The guide lines must be designed in the same direction as you select the 
inclination polylines B.

●     The vertices of the inclination polylines must be exactly on the guide line C.

●     If you select the guide lines C, you must select them in the same direction as the 
inclination polylines B were designed.

To fill an area with a divided blattstitch you can proceed as follows...

Attention! The lower inclination polyline must also be designed with 2 line 
segments!

Command: DBLATT
Select boundary edge 1/<Parameter>: <Ret>
Select boundary edge 1/<Parameter>: P1
Select boundary edge 2: P2
Select inclination lines...
Select entities: P3
Select entities: P4
Select entities: <Ret>

 



CIRBLATT - How to design a circular blattstitch 
with hole 

Toolbar: Blattstitch > Circular blattstitch 

Menu:  Enlarge > Blattstitch > Circular blattstitch

Keyboard: CIRBLATT

With the command you construct a round hole. For construction you must simply 
define the inside and outside radius of the blattstitch. 

The position, where you click the inside radius, is the position, where the blattstitch 
starts. The start is marked with a small red cross. If you realize on punching, that 
the start is at the wrong position, you can use the  MODIFY command to rotate 
the element.

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button. 

Command: CIRBLATT
Center point/<Parameter>: <Ret> 

The following parameters can be defined...

Menu entry Description

Stitches If Yes, all stitches will be designed for the 
technical enlargement.
If No, only stitches at the inclination lines will 
be designed

Color Display color for the enlargement.
Attention: This color setting has no 
influence on punching!

Raedle You can select the desired Raedle from a 
menu. If you change the Raedle, also the 
Density will be adjusted according this 
value.

Density Stitch distance A in millimeter



Over Here you can specify how many percent of 
the total stitch length the system sticks 
behind the boundary. 

After clicking this option you can define 
different overstitch values for both sides. 

Density 
correction

If the blattstitch is getting too narrow, the 
stitch distance should be increased up to the 
double value of the regular blattstitch 
distance.

Shorten 
stitches

To prevent, that stitches are getting too 
dense, stitches can be moved to the inner 
side by a certain value. 

After clicking this option you can first define 
the minimum stitch distance A and then the 
distance B, by which stitches should be 
moved.
If the density is getting smaller than the 
defined distance, the system starts to move 
stitches by the defined value.

Select 
boundary

This option you can switch On/Off. 
If Select boundary is On, you can choose 
an existing circle instead of constructing a 
new one.

Done Exit from the menu and continue with 
defining the center point.

Cancel Interrupt the command

If the parameters are defined correctly and Select boundary is not activated, 
define first the center point and thereafter the inside radius and the outside radius. 
Finally the effect will be constructed and you can continue with the next round 



blattstitch.
If you want to terminate the command, press Return or the right mouse button and 
activate the Cancel option of the popup menu. 

To construct a bored blattstitch proceed as follows...

 

Command: CIRBLATT
Center point/<Parameter>: P1
Inside radius: P2
Outside radius: P3
Center point/<Parameter>: <Ret>
>> Select Cancel from the menu <<



DOT - How to design blattstitch dots  

Toolbar: Blattstitch > Dot 

Menu:  Enlarge > Blattstitch > Dot

Keyboard: DOT

With this command you can construct dots, filled with a blattstitch. For construction 
you simply define the center and the radius of the dot. 

The position, where you click the radius, shows into the direction of the stitches. If 
you realize on punching, that the stitch direction is wrong, you can use the  
MODIFY command to rotate the element.

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button. 

Command: DOT
Center point/<Parameter>: <Ret> 

The following parameters can be defined...

Menu entry Description

Stitches If Yes, all stitches will be designed for the 
technical enlargement.
If No, only stitches at the inclination lines will 
be designed

Color Display color for the enlargement.
Attention: This color setting has no 
influence on punching!

Raedle You can select the desired Raedle from a 
menu. If you change the Raedle, also the 
Density will be adjusted according this 
value.

Density Stitch distance A in millimeter

Over Here you can specify how many percent of 
the total stitch length the system sticks 
behind the boundary. 

After clicking this option you can define 
different overstitch values for both sides. 



Start in middle You can switch On/Off this option.
If Start in middle is off A, the dot starts on 
one side and ends on the other side. The dot 
is made up of a single part.
If Start in middle is on B, the dot is divided 
in two sections, the starting point S and the 
endpoint E of the dot are in the middle of the 
dot. 

Select 
boundary

This option you can switch On/Off. 
If Select boundary is On, you can choose 
an existing circle instead of constructing a 
new one.

Done Exit from the menu and continue with 
defining the center point.

Cancel Interrupt the command

  

If the parameters are defined correctly and Select boundary is not activated, 
define first the center point and then the radius of the dot. Finally the effect will be 
constructed and you can continue with the next dot.
If you want to terminate the command press the right mouse button and use the 
Cancel option of the upcoming menu. 

To construct a dot with 10% over stitch proceed as follows...

Command: DOT 
Center point/<Parameter>: <Ret>
>> Specify Over=10 in the menu <<
Center point/<Parameter>: P1
To point: P2



Center point/<Parameter>: <Ret>
>> Select Cancel from the menu <<



BORPAD - How to design a bored paddle 

Toolbar: Blattstitch > Bored paddle 

Menu:  Enlarge > Blattstitch > Bored paddle

Keyboard: BORPAD

With this command you can construct a bored paddle. The shape of the paddle must 
be designed as a single polyline. 

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button. 

Command: BORPAD
Center point/<Parameter>: <Ret> 

The following parameters can be defined...

Menu entry Description

Stitches If Yes, all stitches will be designed for the 
technical enlargement.
If No, only stitches at the inclination lines will 
be designed

Color Display color for the enlargement.
Attention: This color setting has no 
influence on punching!

Raedle You can select the desired Raedle from a 
menu. If you change the Raedle, also the 
Density will be adjusted according this 
value.

Density Stitch distance A in millimeter

Inside radius Radius R of the hole

Done Exit from the menu and continue with 
defining the center point.

Cancel Interrupt the command

For the other parameters see...

 BLATTSTI - How to design a rotated blattstitch

If the parameters are defined correctly, you must select the polyline. Next you 
specify the uppermost point P2 of the paddle. This point must be outside of the 
element and it defines also the endpoint of inclination line. Finally you must define 
the base line for the upper part of the bored paddle. If you start on the right side 
(see below), the upper part rotates counter clockwise, if you start on the left side, 
the upper part rotates clockwise. 



Command: BORPAD
Select boundary edge/<Parameter>: P1
Select paddle top: P2
Define base line...
From point: P3
To point: P4 

If points 3 and 4 of the base line are laid on the start and the end of the polyline, 
only the rotated part of the effect is constructed. To find the endpoints of the 
polyline you should use object snap END.

Command: BORPAD
Select boundary edge/<Parameter>: P1
Select paddle top: P2
Define base line...
From point: END Snap to endpoint of P3
To point: END Snap to endpoint of P4 

 



GEFLECT - How to construct a rotated geflect  

Toolbar: Geflect > Rotated geflect 

Menu:  Enlarge > Geflect > Rotated geflect

Keyboard: GEFLECT 

With the command GEFLECT a rotated geflect can be constructed.  

The area can be represented by a single closed polyline or by a circle, or it can be represented by two polylines. In case of two polylines, the area must 
be between the two polylines (see below). 

Hint: If the boundary of a blattstitch is made up of more then 
two polylines, you can use the command  BORDER to 
generate a single polyline, which is surrounding the desired 
area.

Directly after having called up the command, you can enter the parameter menu with Return or with a click on the right mouse button.
Command: GEFLECT
Select boundary edge 1/<Parameter>: <Ret> 

The following parameters can be defined...

Menu 
entry Description

Stitches If Yes, all stitches will be designed for the technical enlargement.
If No, only stitches at the inclination lines will be designed

Color Display color for the enlargement.
Attention: This color setting has no influence on punching!

Raedle You can select the desired Raedle from a menu. If you change the Raedle, also the Density will be adjusted according this value.

Density Geflect density A in millimeter



Transition With the transition option you can define variable densities for a single object.

             Off                         Random            0.3>0.9>0.3

See also...

 How to define the transition parameters

Define 
pattern...

Define how the system generates the stitch pattern. 

See also...

 How to define the stitch pattern

Random The rays of the effect have a  random length. The random part can be Inside, Outside or on both sides.

See also...

 How to define a random pattern
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Over Here you can specify how many percent of the total stitch length the system sticks behind the boundary. 

After clicking this option you can define the overstitch value in %. 

Turnstitch If Yes, the system creates a short stitch before the border and a long stitch after the border. The short stitch has the minimum stitch length.
If No, the Geflect turns like a Blattstitch.

Turnstitch = Yes                          Turnstitch = No

Note: with the system variable amd_geflongfac you can specify the factor between the short stitch and the long stitch of turnstitches. By default 



this factor is 1.3, so the long stitch is 1.3 times longer than the short stitch.

You can define this variable in the file DEFAULT.INI.

Done Exit from the menu and continue with selecting boundaries.

Cancel Interrupt the command

If the parameters are defined correctly, select first the geflect boundaries. Thereafter define the inclination lines, whereby the inclination lines must cross 
the geflect boundaries. 

Important! The starting point of the first inclination line specifies the side, on which the geflect starts. The endpoint of the last inclination line defines 
the side, on which the geflect ends.

See also...

 How to define the transition parameters

 How to define the stitch pattern

 How to define a random pattern

 How to define inclination lines

Finally, after having constructed all inclination lines and after having left the inclination line menu with the Build option,  the effect is constructed by the 
system. 

To fill an area with a geflect you can proceed as follows...

Command: GEFLECT
Select boundary edge 1/<Parameter>: P1
Select boundary edge 2: P2
Direction of stitches...
From point/<Parameter>: P3
To point: P4
Direction of stitches...
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From point/<Parameter>: P5
To point: P6
Direction of stitches...
From point: <Ret>
>> Select Build from the menu << 

Note: If the system hangs because of incorrectly defined 
inclination lines, the calculation can be interrupted by pressing 
ESC one or more times. 

 



CGEFLECT - How to fill an area with curves   

Toolbar: Cgeflect > Curvy geflect  

Menu:  Enlarge > Geflect > Curved geflect

Keyboard: CGEFLECT 

With the command CGEFLECT you can fill an area with curves.  

The area can be represented by a single closed polyline or by a circle, or it can be represented by two polylines. In case of two polylines, the area must 
be between the two polylines (see below). 

Hint: If the boundary of a blattstitch is made up of more then 
two polylines, you can use the command  BORDER to 
generate a single polyline, which is surrounding the desired 
area.

Before you can fill the area you must construct the inclination polylines.

Directly after having called up the command, you can enter the parameter menu with Return or with a click on the right mouse button.
Command: CGEFLECT
Select boundary edge 1/<Parameter>: <Ret> 

The following parameters can be defined...

Menu 
entry Description

Stitches If Yes, all stitches will be designed for the technical enlargement.
If No, only stitches at the inclination lines will be designed

Color Display color for the enlargement.
Attention: This color setting has no influence on punching!

Raedle You can select the desired Raedle from a menu. If you change the Raedle, also the Density will be adjusted according this value.

Density Geflect density A in millimeter

Transition Not yet supported



Define 
pattern...

Define how the system generates the stitch pattern. 

See also...

 How to define the stitch pattern

Random The rays can have a  random length. The random part is always outside (at the end of the inclination polylines).

The parameter defines the relation between full ray length and random ray length. This value must be specified in percent (See upper illustration).

Example: If the ray length is 100 mm and the value is 80%, the random ray length can vary from 20 to 100 mm.

Random=30%                Random=70%

Guide 
line(s)

With additional guide lines you can get a smoother distribution of the arcs. The guide lines must also be constructed before you can call up the 
command.

Turnstitch If Yes, the system creates a short stitch before the border and a long stitch after the border. The short stitch has the minimum stitch length.
If No, the Geflect turns like a Blattstitch.
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Turnstitch = Yes                          Turnstitch = No

Note: with the system variable amd_geflongfac you can specify the factor between the short stitch and the long stitch of turnstitches. By default 
this factor is 1.3, so the long stitch is 1.3 times longer than the short stitch.

You can define this variable in the file DEFAULT.INI.

Done Exit from the menu and continue with selecting boundaries.

Cancel Interrupt the command

 
If the parameters are defined correctly, select first the geflect boundaries. Thereafter select the previously designed inclination polylines.

Important! The starting point of the first inclination line specifies the side, on which the geflect starts.

See also...



 How to define the stitch pattern

To fill an area with polylines, the following rules must be respected:

●     All inclination polylines B must be designed in the same direction.

●     All inclination polylines B must be designed with the same number or line respectively arc segments.

●     You cannot mix arc and curve segments in an inclination polyline.

●     An inclination polyline made of arcs must not have corners.

●     The inclination polylines B must be selected in the proper order.

●     If you want to fill an area with rays of random length, the random part is always on the side of the end point of the inclination polylines B.

●     if you fill a closed area A, the imaginary line between the intersection points of the inclination lines B with the area must not intersect the area A.

   dashed line intersects      dashed line does not intersect
             not OK!                              OK!
 

If you use guide lines, the following rules must be respected:

●     The guide lines must be designed in the same direction as you select the inclination polylines B.

●     The vertices of the inclination polylines must be exactly on the guide line C.

●     If you select the guide lines C, you must select them in the same direction as the inclination polylines B were designed.
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To fill an area with curves with random ray length you can proceed as follows...

Command: CGEFLECT
Select boundary edge 1/<Parameter>: <Ret>

>> Define Random=70 in the menu << 

Select boundary edge 1/<Parameter>: P1
Select boundary edge 2: P2
Select inclination lines...
Select entities: P3
Select entities: P4
Select entities: <Ret>



 



PGEFLECT - How to construct a parallel geflect  

Toolbar: Geflect > Parallel geflect 

Menu:  Enlarge > Geflect > Rotated geflect

Keyboard: PGEFLECT

With the command PGEFLECT a parallel geflect can be automatically constructed on 
an existing guide line. You can specify the stitch distance, or the number of stitches, 
which you want to have inserted on one segment. The guide line represents the 
center of the geflect. 

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button.

Command: PGEFLECT
Select guide lines/<Parameters>...
Select entities: <Ret> 

The following parameters can be defined...

Menu 
entry Description

Stitches If Yes, all stitches will be designed for the technical 
enlargement.
If No, only stitches at the inclination lines will be 
designed

Color Display color for the enlargement.
Attention: This color setting has no influence on 
punching!

Raedle You can select the desired Raedle from a menu. If 
you change the Raedle, also the Density will be 
adjusted according this value.

Density Geflect density A in millimeter

Minimum 
stitch 
length

If the stitch is being divided by one of the following 
methods, this value defines the minimum stitch 
length the system allows. 



Turnstitch If Yes, the system creates a short stitch before the 
border and a long stitch after the border. The short 
stitch has the minimum stitch length.
If No, the Geflect turns like a Blattstitch.

Turnstitch = Yes                          Turnstitch = No

Note: with the system variable amd_geflongfac 
you can specify the factor between the short stitch 
and the long stitch of turnstitches. By default this 
factor is 1.3, so the long stitch is 1.3 times longer 
than the short stitch.

You can define this variable in the file 
DEFAULT.INI.

Stitch 
length

If the Stitch length L is unequal to 0, the system 
divides the stitch in a way that the stitches have 
approximately the specified length (See illustration 
of the example below). 

The stitches are distributed unequally. To get this 
uneven distribution, the first stitch has a random 
length. The length is between the Minimum stitch 
length and the Stitch length. The bigger the 
difference between this two values is, the more 
uneven the pattern will be.

No. of 
stitches

The value N specifies, how many times a stitch must 
be divided. Each segment has the same length.
This method results in an even pattern. 



Width Specify the width B of the geflect

Done Exit from the menu and continue with selecting 
boundaries.

Cancel Interrupt the command

If the parameters are defined correctly, select all guide lines and finally the effect is 
constructed by the system. 

To construct a parallel geflect on guide lines you can proceed as follows...

Command: PGEFLECT
Select guide lines/<Parameters>...
Select entities: P1
Select entities: <Ret> 

Attention: If a corner of the guide line is too accurate, the 
system might not be capable to construct a parallel line of  the 
edge.

Attention: The guide line must not be closed!

 

 



STEP - How to design step stitches  

Toolbar: Geflect > Step stitches 

Menu:  Enlarge > Geflect > Step stitches

Keyboard: STEP

With the command STEP, step stitches can be drawn along guide lines. The stitch 
distance respectively the number of stitches per guide line can be defined. 

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button.

Command: STEP
Select guide lines/<Parameters>...
Select entities: <Ret> 

The following parameters can be defined...

Menu entry Description

Color Display color for the enlargement.
Attention: This color setting has no 
influence on punching!

Corner You can define how the system treats 
corners.
If Corner=Yes, the system divides from 
corner to corner to make sure that every 
corner has a segmentation point. In curves 
with a small radius the distance between the 
segmentation point will automatically be 
reduced.
If Corner=No the system ignores corners 
and the distance between the segmentation 
points is always same. 

Corner = Yes              Corner = No

Stitch length Specify stitch distance B. If you specify the 
stitch distance (See illustration of the 
example below) 



No. of stitches The value N specifies, how many times a 
guide line must be divided. 

This effect results in an even distribution of 
stitches.

 

Done Exit from the menu and continue with 
selecting guide lines.

Cancel Interrupt the command

 
If the parameters are defined correctly, select all guide lines and finally the effect is 
constructed by the system. 

If you have drawn the guide lines with a filling function like  PATFILL, you can 
use the entity selection option Previous. Finally the effect is constructed by the 
system. 

To arrange step stitches on guide lines you can proceed as follows...

In the example below the selection of the guide lines is performed with the Fence 
method.

Command: STEP
Select guide lines/<Parameters>...
Select entities: Select Fence from menu
First point of fence: P1
Next point: P2
Next point: <Ret> 
Select entities: <Ret> 



HOEHL - How to construct holes  

Toolbar: Boring > Hoehl 

Menu:  Enlarge > Boring > Hoehl

Keyboard: HOEHL

With this command stitches are designed for Hole elements. The Hole guide lines 
itself can be designed with the function  PATFILL. 

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button.

Command: HOEHL
Select guide lines/<Parameters>...
Select entities: <Ret> 

The following parameters can be defined...

Menu entry Description

Color Display color for the enlargement.
Attention: This color setting has no 
influence on punching!

Raedle You can select the desired Raedle from a 
menu. If you change the Raedle, also the 
Density will be adjusted according this 
value.

Density Stitch distance A in millimeter

Done Exit from the menu and continue with 
selecting guide lines.

Cancel Interrupt the command

If the parameters are defined correctly, select all guide lines and finally the effect is 
constructed by the system. 

If you have drawn the guide lines with a filling function like  PATFILL, you can 
use the entity selection option Previous. Finally the effect is constructed by the 
system. 

To arrange hoehl stitches on guide lines you can proceed as follows...

In the example below the guide lines were constructed with the  PATFILL 
function and selection of the guide lines is performed with the Previous method.

Command: HOEHL
Select guide lines/<Parameters>...
Select entities: P
Select entities: <Ret> 



After all stitches have been designed boring points can be added. 



POINT - How to add boring points  

Toolbar: Boring > Point 

Menu:  Enlarge > Boring > Point

Keyboard: POINT

After picking this function you can indicate with the cross hair cursor the position of 
the Boring points. After insertion of all boring points exit the function by pressing 
<Ret>. 



STEFFEL - How to design a steffel 

Toolbar: Boring > Steffel 

Menu:  Enlarge > Boring > Steffel

Keyboard: STEFFEL

With the command STEFFEL a Steffel can be automatically constructed by picking a 
guide line. The guide line represents the center of the steffel. 

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button.

Command: STEFFEL
Select guide lines/<Parameters>...
Select entities: <Ret> 

The following parameters can be defined...

Menu entry Description

Color Display color for the enlargement.
Attention: This color setting has no 
influence on punching!

Steffel 
distance

Distance A between Zuchole legs (see 
illustration below). 

Steffel width Width B of a the Zuchole (see illustration 
below). 

Density Edge density C (see illustration below) 

Edge width Edge width D (see illustration below) 

Done Exit from the menu and continue with 
selecting guide lines.

Cancel Interrupt the command

If the parameters are defined correctly, select all guide lines and finally the effect is 
constructed by the system. 

To arrange a steffel on guide lines you can proceed as follows...



Command: STEFFEL
Select guide lines/<Parameters>...
Select entities: P1 
Select entities: <Ret> 

Attention: If a corner of the guide line is too accurate, the 
system might not be capable to construct a parallel line of  the 
edge.

Attention: The guide line must not be closed!



How to embroider round holes

After opening a hole with the borer you must embroider round this hole to remove 
the fabric. Various commands are available to embroider round holes with different 
shapes.



GBORER - How to embroider round a hole with an 
irregular shape

Toolbar: Borer holes > Free area hole 

Menu:  Enlarge > Borer holes > Free area hole

Keyboard: GBORER

With this command you can embroider round an irregular hole. The area of the hole 
must be represented by two  closed polylines.

Hint: If the outside boundary of the hole is made up of more 
then one polyline, you can use the command  BORDER to 
generate a single polyline, which is surrounding the desired 
area.

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button.

Command: GBORER
Select boundary edge 1/<Parameter>: <Ret> 

The following parameters can be defined...

Menu entry Description

Stitches If Yes, all stitches will be designed for the 
technical enlargement.
If No, only stitches at the inclination lines will 
be designed

Color Display color for the enlargement.
Attention: This color setting has no 
influence on punching!

Raedle You can select the desired Raedle from a 
menu. If you change the Raedle, also the 
Density will be adjusted according this 
value.

Density Stitch distance A in millimeter

Done Exit from the menu and continue with 
defining the center point.

Cancel Interrupt the command

If the parameters are defined correctly select first the hole boundaries. Thereafter 
define the inclination lines, whereby the inclination lines must cross the hole 
boundary lines.
Important! The starting point of the first inclination line specifies the side, on which 
the effect starts. The endpoint of the last inclination line defines the side, on which 
the effect ends.



See also...

 How to define inclination lines

Finally, after having constructed all inclination lines and after having left the 
inclination line menu with the Build option,  the effect is constructed by the system. 

To embroider round an irrregular area proceed as follows...

Command: GBORER
Select boundary edge 1/<Parameter>: P1
Select boundary edge 2: P2
Direction of stitches...
From point/<Parameter>: P3
To point: P4
Direction of stitches...
.....
To point: Px
From point: <Ret>
>> Select Build from the menu << 

Note: If the system hangs because of incorrectly defined 
inclination lines, the calculation can be interrupted by pressing 
ESC one or more times. 
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CBORER - How to embroider round a circular hole

Toolbar: Borer holes > Circular hole 

Menu:  Enlarge > Borer holes > Circular hole

Keyboard: CBORER

With this command you can embroider round a circular hole. For construction you 
must simply define the center and the outside radius of the hole. 

The position, where you click the radius, is the position, where the effect starts. The 
start is marked with a small red cross. If you realize on punching, that the start is at 
the wrong position, you can use the  MODIFY command to rotate the element.

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button.

Command: CBORER
Center point/<Parameter>: <Ret> 

The following parameters can be defined...

Menu entry Description

Stitches If Yes, all stitches will be designed for the 
technical enlargement.
If No, only stitches at the inclination lines will 
be designed

Color Display color for the enlargement.
Attention: This color setting has no 
influence on punching!

Raedle You can select the desired Raedle from a 
menu. If you change the Raedle, also the 
Density will be adjusted according this 
value.

Stitch length You can define the stitch length A, with 
which you want to embroider round the hole. 
This stitch length defines also the inside 
boundary of the hole.

Select 
boundary

This option you can switch On/Off. 
If Select boundary is On, you can choose 
an existing circle instead of constructing a 
new one.

Density Stitch distance A in millimeter

Done Exit from the menu and continue with 
defining the center point.

Cancel Interrupt the command

 



If the parameters are defined correctly and Select boundary is not activated, 
define first the center point and then the radius of the hole. Finally the effect will be 
constructed and you can continue with the next hole.
If you want to terminate the command press the right mouse button and use the 
Cancel option of the upcoming menu. 

To embroider round an rectangular hole proceed as follows...

Command: CBORER
Center point/<Parameter>: P1
To point: P2
Center point/<Parameter>: <Ret>
>> Select Cancel from the menu <<
 



CBORER - How to embroider round a circular hole

Toolbar: Borer holes > Rectangular hole 

Menu:  Enlarge > Borer holes > Rectangular hole

Keyboard: RBORER

With this command you can embroider round a rectangular hole.

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button.

Command: RBORER
First corner/<Parameter>: <Ret> 

The following parameters can be defined...

Menu entry Description

Stitches If Yes, all stitches will be designed for the 
technical enlargement.
If No, only stitches at the inclination lines will 
be designed

Color Display color for the enlargement.
Attention: This color setting has no 
influence on punching!

Raedle You can select the desired Raedle from a 
menu. If you change the Raedle, also the 
Density will be adjusted according this 
value.

Stitch length You can define the stitch length A, with 
which you want to embroider round the hole. 
This stitch length defines also the inside 
boundary of the hole.

Select 
boundary

This option you can switch On/Off.
If Select boundary is On, you can choose 
an existing rectangle instead of constructing 
a new one.

Density Stitch distance A in millimeter

Done Exit from the menu and continue with 
defining the center point.

Cancel Interrupt the command

 
If the parameters are defined correctly and Select boundary is not activated, two 
diagonal points of the rectangle must be entered. Thereafter the orientation of the 



rectangle can be determined and the starting point (entry point for the puncher) of 
the effect can be defined. Finally the effect will be constructed and you can continue 
with the next hole.

If you want to terminate the command press the right mouse button and use the 
Cancel option of the upcoming menu. 

To embroider round a rectangular hole proceed as follows...

Command: RBORER
First corner/<Parameter>: P1
Other corner: P2
Angle<0>: <Ret>
Starting point: P3
First corner/<Parameter>: <Ret>
>> Select Cancel from the menu <<
 



EBORER - How to embroider round an elliptical 
hole

Toolbar: Borer holes > Elliptical hole 

Menu:  Enlarge > Borer holes > Elliptical hole

Keyboard: EBORER

With this command you can embroider round an elliptical hole. For construction you 
must simply define the two axis of the ellipse and the starting point of the effect.

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button.

Command: EBORER
Center/First endpoint of axis<Parameter>: <Ret> 

The following parameters can be defined...

Menu entry Description

Stitches If Yes, all stitches will be designed for the 
technical enlargement.
If No, only stitches at the inclination lines will 
be designed

Color Display color for the enlargement.
Attention: This color setting has no 
influence on punching!

Raedle You can select the desired Raedle from a 
menu. If you change the Raedle, also the 
Density will be adjusted according this 
value.

Stitch length You can define the stitch length A, with 
which you want to embroider round the hole. 
This stitch length defines also the inside 
boundary of the hole.

Select 
boundary

This option you can switch On/Off.
If Select boundary is On, you can choose 
an existing ellipse instead of constructing a 
new one.

Density Stitch distance A in millimeter

Done Exit from the menu and continue with 
defining the center point.

Cancel Interrupt the command

  
If the parameters are defined correctly and Select boundary is not activated, 



define first the two axis of the ellipse, then the starting point of the effect and finally 
the effect will be constructed and you can continue with the next hole.
If you want to terminate the command press the right mouse button and use the 
Cancel option of the upcoming menu. 

To embroider round an elliptical hole proceed as follows...

Command: EBORER
Center/First endpoint of axis<Parameter>: P1
Second endpoint of axis: P2
Other side: P3
Starting point: P4
Center/First endpoint of axis<Parameter>: <Ret>
>> Select Cancel from the menu <<
 



DBORER - How to embroider round hole like a 
drop

Toolbar: Borer holes > Hole like a drop 

Menu:  Enlarge > Borer holes > Hole like a drop

Keyboard: DBORER

With this command you can embroider round an hole with a shape like a drop. For 
construction you must simply define two points of the circle, the point of the paddle 
and the starting point of the effect.

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button.

Command: DBORER
Point 1/<Parameter>: <Ret> 

The following parameters can be defined...

Menu entry Description

Stitches If Yes, all stitches will be designed for the 
technical enlargement.
If No, only stitches at the inclination lines will 
be designed

Color Display color for the enlargement.
Attention: This color setting has no 
influence on punching!

Raedle You can select the desired Raedle from a 
menu. If you change the Raedle, also the 
Density will be adjusted according this 
value.

Stitch length You can define the stitch length A, with 
which you want to embroider round the hole. 
This stitch length defines also the inside 
boundary of the hole.

Select 
boundary

This option you can switch On/Off.
If Select boundary is On, you can choose 
an existing drop instead of constructing a 
new one.

Density Stitch distance A in millimeter

Done Exit from the menu and continue with 
defining the center point.

Cancel Interrupt the command

 



If the parameters are defined correctly and Select boundary is not activated, 
define first two points on the circle, the point of the paddle and the starting point of 
the effect. Finally the effect will be constructed and you can continue with the next 
hole.
If you want to terminate the command press the right mouse button and use the 
Cancel option of the upcoming menu. 

To embroider round a hole like a drop proceed as follows...

Command: DBORER
Point 1/<Parameter>: P1
Diameter: P2
Select paddle top: P3
Starting point: P4
Point 1/<Parameter>: <Ret>
>> Select Cancel from the menu <<

Hint: The stitch density on the two sides of the drop is not 
equal. To correct the density on one side just use the  
MODIFY command to change the density of the corresponding 
inclination line.



STAR - How to design star dots  

Toolbar: Embroidery > Star dot 

Menu:  Enlarge > Star dot

Keyboard: STAR

This function generates star dots. For construction you must simply define the center 
and the outside radius of the star dot. 

The position, where you click the radius, is the position, where the star dot starts. 
The start is marked with a small red cross. If you realize on punching, that the start 
is at the wrong position, you can use the  MODIFY command to rotate the 
element.

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button. 

Command: STAR
Center point/<Parameter>: <Ret> 

The following parameters can be defined...

Menu entry Description

Color Display color for the enlargement.
Attention: This color setting has no 
influence on punching!

Raedle You can select the desired Raedle from a 
menu. If you change the Raedle, also the 
Density will be adjusted according this 
value.

Density Stitch distance A in millimeter

Select 
boundary

This option you can switch On/Off. 
If Select boundary is On, you can choose 
an existing circle instead of constructing a 
new one.

Done Exit from the menu and continue with 
defining the center point.

Cancel Interrupt the command

 

If the parameters are defined correctly and Select boundary is not activated, 
define first the center point and then a point on the boundary. Finally the effect is 
constructed by the system and you can continue with the next dot. 

If you want to terminate the command press the right mouse button and use the 
Cancel option of the upcoming menu. 



To construct a star you can proceed as follows...

Command: STAR 
Center point/<Parameter>: P1
To point: P2
Center point/<Parameter>: <Ret> 



ZUCHOLE - How to construct a Zuchole 

Toolbar: Embroidery > Zuchole 

Menu:  Enlarge > Zuchole

Keyboard: ZUCHOLE

With the command ZUCHOLE you can construct a single sided or double sided 
zuchole by picking the guide line. In case of a single sided zuchole, the guide line 
represents the base line, in case of a double sided zuchole, the guide line represents 
the center of the zuchole. 

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button.

Command: ZUCHOLE
Select guide lines/<Parameters>...
Select entities: <Ret> 

The following parameters can be defined...

Menu entry Description

Color Display color for the enlargement.
Attention: This color setting has no 
influence on punching!

Steffel 
distance

Distance A between Zuchole legs (see 
illustration below). 

Steffel width Width B of a the Zuchole (see illustration 
below). 

No. of stitches Select number of stitches C per zuchole leg. 

Zuchole type Choose between single sided and double 
sided zuchole. 

Single sided zuchole

Double sided zuchole



Done Exit from the menu and continue with 
selecting guide lines.

Cancel Interrupt the command

If the parameters are defined correctly, select all guide lines and finally the effect is 
constructed by the system. 

To arrange step stitches on guide lines you can proceed as follows...
Command: ZUCHOLE
Select guide lines/<Parameters>...
Select entities: select guide line
Select entities: <Ret> 

Attention: If a corner of the guide line is too accurate, the 
system might not be capable to construct a parallel line of  the 
edge.

Attention: The guide line must not be closed!

 

Notice: If the single sided zuchole is drawn on the wrong side 
of the guide line, you must change the direction of the polyline. 
You can do this with the command  PLCONV. Then you can 
use the UPDATE or MODIFY command to rebuild the zuchole. 



PICO - How to design lock stitches  

Toolbar: Embroidery > Pico 

Menu:  Enlarge > Pico

Keyboard: STEP

With this command lock or join stitches can automatically be constructed by picking 
guide lines. A guide line represents the center of the join stitches. 

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button.

Command: PICO
Select guide lines/<Parameters>...
Select entities: <Ret> 

The following parameters can be defined...

Menu entry Description

Color Display color for the enlargement.
Attention: This color setting has no 
influence on punching!

Raedle You can select the desired Raedle from a 
menu. If you change the Raedle, also the 
Density will be adjusted according this 
value. 

Density Pico stitch distance A in millimeter 

Width Width B of the pico 

Done Exit from the menu and continue with 
selecting guide lines.

Cancel Interrupt the command

If the parameters are defined correctly, select all guide lines and finally the effect is 
constructed by the system. 

To arrange step stitches on guide lines you can proceed as follows...



Command: PICO
Select guide lines/<Parameters>...
Select entities: P1
Select entities: <Ret> 



UNDER - How to add underlayers

Toolbar: Embroidery > Underlayer 

Menu:  Enlarge > Underlayer

Keyboard: UNDER

With this command you can underlayers to a Blattstitch. Before you can design 
underlayers you must have a Blattstitch. To add underlayers just choose the type of 
underlayer and select the corresponding Blattstitch.

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button.

Command: UNDER
Select Blattstitch<Parameter>: <Ret> 

The following parameters can be defined...

Menu entry Description

Standard Standard underlayer along the boundaries of 
the blattstitch.

Chemical 1

Chemical 2



Chemical 3

Offset Distance A of the underlayer from the 
boundary.

Shift Shift defines the density of the underlayer. It 
is the relation between blattstitch density and 
underlayer density. Values between 1 and 29 
are possible.

Done Exit from the menu and continue with 
defining the center point.

Cancel Interrupt the command

 
If the parameters are defined correctly just select the blattstitches and the 
underlayers will be constructed.
If you want to terminate the command press the right mouse button and use the 
Cancel option of the upcoming menu. 

To add an underlayer Chemical 1 to a blattstitch proceed as follows...



Command: UNDER
Select Blattstitch<Parameter>: <Ret>
>> Select Chemical 1 from the menu <<
Select Blattstitch<Parameter>: P1
Select Blattstitch<Parameter>: <Ret>
>> Select Cancel from the menu <<



Embroidery macros 

A macro is a complex embroidery element like a flower or a border. The whole 
geometry with all stitches can be constructed by defining a few parameters. 



MFLOWER - How to construct a flower 

Toolbar: Embroidery macros > Flower macro 

Menu: Enlarge > Flower macro

Keyboard: MFLOWER

With the flower macro you can construct almost all kind of flowers. To construct a 
flower, first setup the parameters and then define the geometry. 

 
Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button.

Command: MFLOWER
Center point/<Parameter>: <Ret>

The following parameters can be defined...

Menu entry Description

Stitches Select the embroidery effect, which must be 
applied to the flower. You can choose 
between None, Blatt stitch, Abbohr 
effect and Hole. 

Stitch 
direction

This option appears only in case of stitch 
type Blatt stitch. You can choose between 
stitch direction Horizontal and Vertical.

Effect 
parameters

This option appears only if the stitch type is 
not None. The parameter menu of the 
selected stitch type is opened and you can 
setup the desired embroidery parameters.

Bottom closed If no, radial lines lead to the center of the 
segment. If yes, the bottom of the segment 
is closed with an arc. 



Tangentially  If no, the lower part of the segment and the 
upper arcs don’t have a smooth, tangential 
transition. They form a corner at distance A 
from the center. If yes,  the lower part of the 
segment and the upper arcs have a smooth, 
tangential transition. 

Top angle The value defines the deviation angle of the 
segment top from the tangent. A positive 
angle results in a pointed arch, a negative 
angle results in a heart, a 0 results in an 
ordinary arch. 

Like an arrow If yes, the segment top looks like an arrow.

Hight-factor This parameter appears only if Like an 
Arrow=yes. It defines the portion of the 
arrow on the segment height. The value can 
be between 0 and 0.5. 

Segments Specifies the number of paddles of the 
flower.

Segment 
width

If you specify the segment width, the number 
of segments is derived from this value. You 
must define the width of a segment at the 
inside radius.

Segment 
space

Specify the space between two segments in 
mm. 

Done Exit from the menu and continue with 
selecting guide lines.



Cancel Interrupt the command

If the parameters are defined correctly, define first the center point and thereafter 
the inside radius and the outside radius of the flower. Finally the flower is 
constructed by the system. 

To construct a flower you can proceed as follows...

Command: MFLOWER
Center point/<Parameter>: P1
Inside radius: P2
Outside radius: P3 

If Tangentially=no, the system will also ask you additionally for the distance to 
arcs begin. 

Command: MFLOWER
Center point/<Parameter>: P1
Inside radius: P2
Outside radius: P3
Distance to arcs begin<0>: P4 

 

 



MBORDER - How to construct a border 

Toolbar: Embroidery macros > Border macro 

Menu: Enlarge > Border macro

Keyboard: MBORDER

With the border macro you can arrange many different kinds of effects along a 
polyline. To construct a border, first setup the parameters and then select the 
guideline, where the effect should be arranged. 

Directly after having called up the command, you can enter the parameter menu 
with Return or with a click on the right mouse button.

Command: MBORDER
Select guide line/<Parameters>: <Ret>

The following parameters can be defined...

Menu entry Description

Stitches Select the embroidery effect, which must be 
applied to the flower. You can choose 
between None, Blatt stitch, Abbohr 
effect and Hole. 

Stitch 
direction

This option appears only in case of stitch 
type Blatt stitch. You can choose between 
stitch direction Horizontal and Vertical.

Effect 
parameters

This option appears only if the stitch type is 
not None. The parameter menu of the 
selected stitch type is opened and you can 
setup the desired embroidery parameters.

Bottom closed If no, radial lines lead to the center of the 
segment. If yes, the bottom of the segment 
is closed with an arc. 



Tangentially  If no, the lower part of the segment and the 
upper arcs don’t have a smooth, tangential 
transition. They form a corner at distance A 
from the center. If yes,  the lower part of the 
segment and the upper arcs have a smooth, 
tangential transition. 

Top angle The value defines the deviation angle of the 
segment top from the tangent. A positive 
angle results in a pointed arch, a negative 
angle results in a heart, a 0 results in an 
ordinary arch. 

Like an arrow If yes, the segment top looks like an arrow.

Hight-factor This parameter appears only if Like an 
Arrow=yes. It defines the portion of the 
arrow on the segment height. The value can 
be between 0 and 0.5. 

Segments Specifies the number of paddles of the 
flower.

Segment 
width

If you specify the segment width, the number 
of segments is derived from this value. You 
must define the width of a segment at the 
inside radius.

Segment 
space

Specify the space between two segments in 
mm. 

Done Exit from the menu and continue with 
selecting guide lines.



Cancel Interrupt the command

If the parameters are defined correctly, select first the guide lines and thereafter the 
heightof the segment. Finally the border is constructed by the system. 

To arrange a border macro on a guide line you can proceed as follows...

Command: MBORDER
Select guide line/<Parameters>: P1
Distance to arcs top <0>: A 

If Tangentially=no, the system will also ask you additionally for the distance to 
arcs begin. 

Command: MBORDER
Select guide line/<Parameters>: P1
Distance to arcs top <0>: A
Distance to arcs begin<0>: B 

 



How to modify embroidery effects

Embroidery effects can easily be modified. There are various commands at your 
disposal to perform this tasks.



DELEMB - How to delete embroidery objects 

Toolbar: Embroidery > Delete embroidery objects 

Menu:  Enlarge > Delete embroidery objects

Keyboard: STEP

Elements, generated by embroidery functions, can be erased by picking the guide 
line or one of the generated elements. 

Comando: DELEMB
Select guidelines ...
Select entities: select enlarged object
Select entities: <Ret> 

Hint: It is not necessary to erase embroidery elements if you 
have selected wrong parameters and if you want to correct the 
element. In this case use the  MODIFY command and 
select the new parameter. The system will automatically update 
the effect according the new parameters. 

 



MODIFY - How to modify embroidery effects 

Toolbar: Modify embroidery objects > Modify embroidery objects 

Menu:  Enlarge > Modify embroidery objects

Keyboard: MODIFY

With the MODIFY command you can correct the parameters of an embroidery effect 
or you can also change the effect by itself (e.g. from Steffel to Zuchole or from 
Single Edge to Double Edge). 

How to modify the parameters of an effect
After calling up the command you can select the object, which you want to change. 
After having selected the element, a popup menu will be displayed with the actual 
parameters of the effect. 

Make the desired changes and apply the changes with Rebuild. The effect will be 
rebuilt according the new parameters.

If you are satisfied with the result you can leave the menu with the option Done.

How to change the direction of a Geflect or Blattstitch or the side 
of a Zuchole
If the selected element is a Geflect, Blattstitch or Zuchole, you can also find the 
option Invert in the menu.

In case of the Geflect or Blattstitch you can change the direction. Changing the 
direction results in moving the starting point to the end. This can be necessary for 
the puncher in case that he wants to enter the effect at the end.

In case of the single sided Zuchole you can change the side, on which the Zuchole 
will be constructed.

How to modify the effect type
If you want to change the effect e.g. from a single edge to a double edge, you can 
select the desired effect from the upper part of the popup menu.
After having selected the new embroidery type, the popup menu contains the 
parameters of the new effect. Make the desired changes and apply the changes with 
Rebuild. The old effect will be removed and the new effect will be generated 
according the defined parameters.

If you are satisfied with the result you can leave the menu with the option Done.

How to rotate circular objects
For some embroidery objects like the STAR, the DOT, the circular blattstitch 
CIRBLATT and the circular borer CBORER you define first the center point and 
then the radius. The point, where you specify the radius is also the starting point of 
the punched object. In many cases the puncher must move this starting point to 
another position by rotating the object around the center point. This rotation can be 



performed via the Rotate option.

If you select an object of this type you can also find the option Rotate. After the 
selection you can specify the rotation angle or you can choose the option 
Reference to define first a reference angle and then the new angle.

How to modify inclination lines
Like ordinary embroidery objects, also inclination lines can be modified. If you select 
an inclination line for modification, a popup menu will be displayed with the actual 
parameters of the inclination line. Make the desired changes and apply the changes 
with Rebuild. The Blattstitch or the Geflect will be rebuilt according the new 
parameters.

You can also leave the menu with the option Done. In this case, the new 
parameters will be applied, but the effect will not yet be rebuilt.

See also...

 How to define inclination lines

How to move the start- or the endpoint of an effect to the other side

With the option Invert you can change the side, on which an effect starts 
respectively ends. If you want e.g. move the starting point of an effect from inside to 
outside, just select the first inclination line and click Invert. Now the effect will be 
rebuilt with the starting point on the other side of the effect. The same can be done 
with the endpoint.

Note: Invert is useful only for the first and for the last 
inclination line of an effect. In all other cases it has no effect.

How to modify the stitch length of manually punched turns
If the selected object is a group of manually punched stitches you can change the 
stitch length. Changing the stitch length modifies only the stitch distance of stitches, 
which are aligned on a straight line. Corner stitches of such a group will not be 
affected.

Example:

Change the stitch length from 7mm to 3.5mm:

Before change 7mm            After change 3.5mm
 

file:///G|/Volume3/Dieter/Products/ProArt-ProLace/ProArt-ProLace2v0/Manual/English/HTML/c8-inclines.htm


Note: This possibility can result in unwanted effects if the user 
does not know exactly what he does! Therefore this option can 
be switched On or Off.
To switch this option on you must set the variable 
amd_manstiedit=1 otherwise set the variable 
amd_manstiedit=0. The variable can be set in the file 
DEFAULT.INI.



UPDATE - How to update stitches of embroidery 
effects 

Toolbar: Modify embroidery objects > Update embroidery objects 

Menu:  Enlarge > UPDATE embroidery objects

Keyboard: UPDATE

If you change the position of inclination lines of a blatt stitch, of a geflect etc., or if 
you change the inclination line type (through, floating, regular), or if you change the 
size of an element, the stitches are not automatically corrected. This correction can 
be performed with the command UPDATE. 

After calling up the command you must select the effect, which must be updated, 
thereafter the system rearranges the stitches according the new position of the 
inclination lines or according the new size of the effect. 

 
1.  Original blattstitch

2.  Blattstitch with corrected inclination lines and inclination line types.

3.  Blattstitch after update with the UPDATE command.

Command: UPDATE
Select guide line: P1 

 



DENSITY - How to modify the density of 
embroidery objects  

Toolbar: Modify embroidery objects > Correct density 

Menu:  Enlarge > Density correction

Keyboard: DENSITY

With the command DENSITY you can correct the density of all embroidery objects 
of the design. You can also select the objects, which you want to have changed. 

After calling up the command a menu opens.

You can choose from the following options....

Menu entry Description

All All embroidery objects of the design are 
modified.

Select You can select the embroidery objects, which 
you want to have changed.

 

After having selected the objects you can choose in another menu, which 
embroidery effects should be modified. 

You can choose from the following options....

Menu entry Description

All The density of all embroidery objects will be 
corrected.

Blattstitch If selected, the density of all blattstitch types 
will be corrected.

Edge If selected, the density of Edges, wiggle 
stitches and bored effects will be corrected.

Geflect If selected, the density of geflect and step-
stitches will be corrected.

Steffel If selected, the density of steffel objects will 
be corrected.

Borer If selected, the density of BORER  objects will 
be corrected. (Objects, created with the 
commands GBORER, DBORER, etc.)



Density 
correction

Specifies, how much the density is corrected. 
The value must be defined in %. 

Example:

A value of -20% means, that an object with 
a stitch distance of 1mm will have a stitch 
distance of 1.2mm after the correction.

Done Exit from the menu and perform the density 
correction.

Cancel Interrupt the command



Punching with ProLace

ProLace, the combined Embroidery Design and Punching program allows you to 
directly punch on ProArt/ProLace designs. The embroidery elements automatically as 
technical enlargements. The exact number of turns can be determined for elements, 
which are designed in this way and you can use ProLace to directly take over these 
elements.

All punching tasks can be performed with the command  TURNS. This command 
serves to punch manually, to insert underlayers and modules, to insert machine 
functions and to connect manually punched stitches with previously created 
embroidery objects like Blattstitches, Edges etc.

To carry out modifications you can use the command  MODIFY. This command 
allows you to insert stitches, to remove stitches, to break apart punched sequences, 
to insert and to remove machine functions, etc.

The command  OUTPUT serves to export the punching data to a machine 
readable file, and the  INPUT command serves to import low level format file for 
editing. 

The Punching Toolbar contains the following commands...
 
 Punching Toolbar

TURNS - How to punch and connect with embroidery 
objects

MODIFY - How to modify punched sequences and 
functions

NP - Needle programming

OUTPUT - How to export punching data

INPUT - How to import punching data for editing



TURNS - How to punch and connect with 
embroidery objects

Toolbar: 

Menu:  -

Keyboard: TURNS

With this command you can

●     punch a sequence of manual stitches

●     you can make underlayers

●     place modules along a given line

●     insert machine functions or

●     connect with embroidery elements, which were designed with ProArt/ProLace 
automatic stitches.

How to start a punching session
If you call the command for the first time for a design, you have to specify the 
desired punching parameters and the starting point of the design.

See also...

 How to start a punching session

How to define the starting point of a new sequence
If the starting point is just given, you can specify the starting point for a new 
punching sequence or you can enter a menu from where you can choose from 
additional options.

See also...

 How to define the starting point

How to define vertices
After having defined the starting point of a sequence, you can manually punch stitch 
by stitch, or you can enter a menu from where you can choose from additional 
options. 

See also...

 How to define vertices

  

Liza
Comment on Text
C помощью этой команды вы можете
. создать последовательно стежки с произвольной длиной
. создать индивидуальную предварительную прострочку (underlay)
. установить функции для вышивальной машины. это тоже пока не могу описать

Liza
Comment on Text
TURNS - Как создать объекты вышивки



How to start a punching session

If you call the punching command for the first time from a certain design, you will 
get a menu, where you can specify the desired punching parameters. With this 
parameters you define, which bore respectively color change program will be used 
and which functions are available during punching.

After having defined all the parameters you can specify the starting point of the 
design. The starting point is represented by a green triangle. A vertical line will also 
be inserted in the starting point.

After having defined the starting point you start punching.

See also...

 How define vertices

How to define the output format

First you have to select the format, which you would like to use.

You can choose one of the following options...

Menu entry Description

SLC-Plauen Saurer Low level code for Plauen machines

SLC-Saurer Saurer Low level code for Saurer machines

SHC Saurer High level code

Hiraoka DAT Hiraoka DAT format

Lässer MST New Lässer MST format

Tajima Tajima Multihead format

Done Exit from the menu and continue.

Cancel Interrupt the command

How to setup punching parameters

After having selected the desired format another menu will be displayed, where you 
can define boring, color change and function automatic. 

You can choose one of the following options...

Menu entry Description

Color change Switch color change On/Off and define 
Needle colors, initial repeat and the color 
change program.

Liza
Comment on Text
Как начать создание объектов вышивки

Liza
Comment on Text
Если после открытия программы вы впервые набрали команду TURNS то перед вами откроется ряд меню позволяющих настроить параметры будущего дизайна. Такие как цвет, параметры машины, параметры ввода объектов. Эти параметры в дальнейшем будут использоваться по умолчанию в течении работы. После установки всех параметров вы сможете определить начальную точку, которая будет представлена на рабочем поле в виде зеленого треугольник. Через треугольник также будет проходить вертикальная красная линия. 



Borer Switch Boring On/Off and select the borer 
program and the initial Borer size in case of 
SLC-Saurer, SLC-Plauner, Hiraoka or Lässer 
mode.

Function 
automatic

Switch Function automatic On/Off. With 
Function automatic On, the system 
automatically inserts functions like BSTI, 
QSTI, etc.

Done Exit from the menu and continue.

Cancel Interrupt the command

 

Color change
If color change is on, color change functions will be available in the function menu.

The color change settings depend on the previously selected format.

SLC-Saurer, SLC-Plauen and Hiraoka mode

In case of SLC-Saurer, SLC-Plauen and Hiraoka mode a menu will be displayed, 
where you can select the color change program, the needle colors and the start 
repeat.

You can choose one of the following options...

Menu entry Description

Off Switch color change off

Programs, e.g. 
Saurer 
Pentamat old

Select a color change program. 

Up to 10 programs for different machine 
types can be defined. The programs are filed 
in the file FRWPROG.CSV, which is located 
in the directory C:\Icad\Bib\Data

Needle With this option you can define the display 
color of each single needle. The number of 
needles depend on the repeat, which you 
have defined with the command  SETUP. 
In case of a 12/4 repeat you can define the 
color for 3 needles.

Start repeat By default, the start repeat of the design 
corresponds with the repeat, which you have 
defined with the command  SETUP. With 
this option you can change the start repeat.



Done Exit from the menu and continue.

SHC, Lässer and Tajima mode

In case of SHC, Lässer or Tajima format you can just define the needle colors.

You can choose one of the following options...

Menu entry Description

Needle With this option you can define the display 
color of each single needle. The number of 
needles depend on the repeat, which you 
have defined with the command  SETUP. 
In case of a 12/4 repeat you can define the 
color for 3 needles.

Done Exit from the menu and continue.

 

Borer
If bore is on, bore functions will be available in the function menu.

The bore settings depend on the previously selected format.

SLC-Saurer, SLC-Plauen and Hiraoka mode

In case of SLC-Saurer, SLC-Plauen and Hiraoka mode a menu will be displayed, 
where you can select the default bore program for the design.

You can choose one of the following options...

Menu entry Description

Off Switch color change off

Programs
e.g. 
STANDARD, 
SHORT

Select a borer program. 

Up to 10 programs for different machine 
types can be defined. The programs are filed 
in the file BORPROG.CSV, which is located 
in the directory C:\Icad\Bib\Data

Borer size You can specify the initial borer size

Done Exit from the menu and continue.

SHC, Lässer and Tajima mode



You can just switch On/Off the bore mode.

Function automatic
In a design there are many functions, for which the system automatically can switch 
the correct functions. An example is the Blattstitch. If Function automatic is on, 
the system does not offer the BSTI function in the function menu and the function is 
automatically inserted by the system.

In the file DEFAULT.INI in the program directory you can specify, which functions 
should be switched automatically.

Variable Description

amd_autobsti If 1 the BSTI function will be switched 
automatically.

amd_bstimin Specifies the stitch length in mm when 
the blattstitch function should be 
switched on. By default this value is set 
to 3.5mm.

amd_autostg If 1 the STG function will be switched 
automatically.

amd_autofast If 1 the system automatically switches to 
FAST mode after Needle On and to 
SLOW mode before Needle off.

amd_autonrempty If 1 the system inserts an empty stitch 
before Needle on and after Needle off.



How to define the starting point

After calling up the command you can specify the starting point, or you can enter a 
menu with Return or with a click on the right mouse button.

Command: TURNS
From point: <Ret>

The following actions can be performed...

Menu entry Description

Stitches If yes, a mark will be placed on the stitches 

Modules Define a sequence of stitches and place them 
along a polyline

Underlayers Design underlayers on a polyline

Continue at 
end

Start the new sequence directly  at the end 
of the first punched sequence. This is the 
sequence, which starts with the START-
function.

Connect with 
endpoint

Connect the starting point of the new 
sequence with the end point of a previous 
sequence or with an automatic stitch. 

Connect with 
pickpoint

Connect the starting point of the new 
sequence with a previous sequence or with 
an automatic stitch. The connection will be 
made at a definable point. If necessary the 
element, with which you want to connect, will 
be cut.

Done Leave the menu and continue with the 
definition of the starting point.

Cancel Interrupt the command

With Done you can leave the menu and continue with the definition of the starting 
point.

Shortcut keys
Several options are directly available by pressing a key on the keyboard. The 
following shortcut keys are available...

M - Module

U - Underlayer

E - Continue at end

C - Connect with endpoint

D - Done



How to start at the end of the first punched sequence
With the option Continue at end you can start a new punching sequence at the 
end of the first punched sequence (the sequence, which starts with the START-
function). After calling up this option, the system looks for the end of the first 
sequence, moves the view to this point and you can continue punching.

How to start at the end of a punched sequence or at the end of an 
automatic stitch
With the option Connect with endpoint you can start a punching sequence at the 
end of another sequence or at the end of an automatic stitch like Blattstitch, Edge, 
Geflect, etc.

After calling this option you can select the element, from which you want to start.
Select guide line: select element

If the you want to connect e.g. with a blattstitch, which is not yet included in a 
punching sequence, select the blattstitch close to the side, where you want to start. 
The system will snap to the end, which is closer to the pick point (indicated by an 
arrow).

Select guide line: P1
To point: Total=123: P2
To point: Total=124: P3
To point: Total=125: Px

If you want to connect with a ready punched sequence of elements, just click on an 
element of the sequence and the system will snap to the end of the sequence 
(indicated by an arrow).



Select guide line: P1
To point: Total=123: P2
To point: Total=124: P3
To point: Total=125: Px

Hint: For quick access to this option, you can also use the C-
key on the keyboard.

How to start at a certain point of a punched sequence or of an 
automatic stitch
With the option Connect with pickpoint you can start a punching sequence at the 
point, where you selected the object. The selected object will be cut to the end and 
the new sequence will start at the pick point.

After calling this option you can select the element at your desired starting point.
Select guide line: select element

If the you want to connect e.g. with a single edge, just select the edge at the 
desired connection point. The edge will be cut to the end and the new sequence will 
start at this point.

Select guide line: P1
To point: Total=123: P2
To point: Total=124: P3
To point: Total=125: Px

Note: You can use this option only to connect with objects, 
which are based on a single polyline. This are e.g. edge, 
zuchole, step-stitch, wiggle-stitch. You cannot connect with a 
blattstitch, geflect, etc.

 



See also...

 How to use modules

 How to design underlayers



How to define vertices

After having defined the starting point of a sequence, you can manually punch stitch 
by stitch, or you can enter an option menu with Return or with a click on the right 
mouse button.  

Command: TURNS
From point: vertex 1
To point: Total=0: vertex 2
To point: Total=1: vertex 3
...
To point: Total=x: <Ret>

The following actions can be performed...

Menu entry Description

Insert a 
machine 
function

You can choose from a selection of possible 
machine functions. The selection of  
functions, which you can insert, depends on 
the actual situation and on the definitions, 
which you made on start of a punching 
session. 

See also...

 How to insert machine functions

Color Display color for manually punched stitches.
Attention: This color setting has no 
influence on the needle!

Maximum 
stitch length

Manually punched stitches are divided, if the 
punched stitch length is longer than the 
length, defined by this value.

Modules Define a sequence of stitches and place them 
along a polyline

Underlayers Design underlayers on a polyline

Connect with 
endpoint

Connect the last point of the actual sequence 
with the starting point of another sequence 
or automatic stitch. 

Connect with 
pick point

Connect the last point of the actual sequence 
with another sequence or with an automatic 
stitch. The connection will be made at a 
definable point. The object, with which you 
connect, will be cut.

End command Terminate the command

Done Leave the menu and continue with the 
definition of vertices.



Undo Undo the last manually punched stitch. 
Underlayers or modules cannot be undone.

Cancel Interrupt the command

With Done you can leave the menu and continue with the definition of vertices. 

Hint:  In the lower left corner of the status line you can see 
the actual number of turns from the start of the actual 
punching sequence. 

Shortcut keys
Several options are directly available by pressing a key on the keyboard. The 
following shortcut keys are available...

M - Module

U - Underlayer

C - Connect with endpoint

S - Insert Split function

E - End command

D - Done

B - Undo (Back)

1-9 - Set Maximum stitch length according the pressed digit. 1 is 1mm, 9 is 9mm.

How to connect with the start of a punched sequence or automatic 
stitch
With the option Connect with endpoint you can connect with the start of an 
already punched sequence or with an automatic stitch like Blattstitch, Edge, Geflect, 
etc.

After calling this option you can select the element, with which you want to perform 
the connection.

Select guide line: select element

If you want to connect e.g. with a blattstitch, select the blattstitch close to the side, 
where you want to connect. The system will snap to the end, which is closer to the 
pick point (indicated by an arrow). After having performed the connection, the 
system jumps to the other end of the blattstitch and you can immediately continue 
punching.



To point: Total=123: P1
To point: Total=124: <Ret>

Select Connect with endpoint from the menu

Select guide line: P2
To point: Total=156: P3
To point: Total=157: P4
To point: Total=158: Px

If you want to connect with a ready punched sequence of elements, just click on an 
element of the sequence and the system will snap to the start of the sequence 
(indicated by an arrow).

To point: Total=123: P1
To point: Total=124: <Ret>

Select Connect with endpoint from the menu

Select guide line: P2
To point: Total=156: P3
To point: Total=157: P4
To point: Total=158: Px

Hint: For quick access to this option, you can also use the C-
key on the keyboard.

How to connect at a point of a punched sequence or automatic 
stitch
With the option Connect with pickpoint you can connect with an already punched 
sequence at the point, where you select the object. The selected object will be cut at 
the pick point.



After calling this option you can select the element at your desired starting point.
Select guide line: select element

If you want to connect e.g. with a single edge, just select the edge at the desired 
connection point. The edge will be cut to the closer end and the actual sequence will 
be connected with the edge at the break point. After having performed the 
connection, the system jumps to the other end of the edge and you can immediately 
continue punching.

To point: Total=123: P1
To point: Total=124: <Ret>

Select Connect with pickpoint from the menu

Select guide line: P2
To point: Total=158: Px

Note: You can use this option only to connect with entities, 
which are based on a single polyline. This are e.g. edge, 
zuchole, step-stitch, wiggle-stitch. You cannot connect with a 
blattstitch, geflect, etc.

How to divide long stitches
To prevent too long stitches, you can define the Maximum stitch length. If the 
manually punched stitch is longer than the maximum stitch length, the system 
automatically divides the long stitch. 

How to work with edge pan
If the you insert a stitch close to the border of the graphics area, the display is 
automatically moved in a way, that the new point is in the center of the screen.

See also...

 How to insert machine functions

 Description of machine functions

 How to use modules

 How to design underlayers



How to insert machine functions

In the upper part of the menu you find a selection of machine functions, which can 
be inserted at the actual position. The selection of machine functions depends on the 
actual status of the machine and on the definitions, which you made on start of a 
punching session.

Status of machine functions
The status of  functions, which have e certain value, is displayed right from the 
function description.

Borer size = 7

To change the value just click on the menu entry and choose the new value. 
Depending on the function you can choose the new value from a menu...

or you just enter the new value by keyboard.

The status of functions, which can be switched on and off, is also visible in the menu 
entry. A double arrow right from the function description indicates, that the function 
is on. If the double arrow is missing, the function is off.

Needle roller <<
Borer



To switch the function just click on the menu entry. If the actual status is On the 
function will be switched of and vice versa.

Number of turns and more/less display 
The actual number of turns are always displayed in the status line. In case of Plauen 
system also the status of more/less is displayed.

To point: Total=0, (+):

See also...

 Description of machine functions

 



How to insert underlayers

Underlayers can be inserted automatically along a polyline or along an embroidery 
element like an edge. You can insert up to 9 layers. After the first layer, the system 
produces wiggle stitches.

Note: If you want to insert underlayers along an edge you 
should use the green dashed line of the edge. This line can also 
be moved from the center to consider the thread tension.

After having selected the Underlayer option from the previous menu you should 
choose the polyline or embroidery element, along which you want to arrange the 
underlayers. Next you can define, where the underlayers should start and where 
they should end. If you confirm the enquiries with Return, the endpoints of the 
polyline will be taken over as start- and endpoint for the underlayer generation.

Command: TURNS
From point: vertex 1
To point: Total=0: vertex 2
To point: Total=1: vertex 3
...
To point: Total=x: <Ret>

>> Select option Underlayers from the menu <<

Select guide line: select
From point: underlayer start
To point: underlayer end

Now the underlayer menu is displayed.

You can choose one of the following options...

Menu entry Description

Total number 
of underlayers

Total T number of layers, which should be 
inserted along the selected element.

Start layer Layer S, with which you want to start. By 
default the start layer is 1.

Actual number 
of underlayers

Number N of layers, which you want to insert 
now.  

Underlayer 
distance

Stitch length A of underlayer stitches.

Width Wiggle width B. This value will only be of 
meaning if more than one layer is designed.

Build Generate the underlayers and return to the 
previous menu.

Cancel Interrupt designing underlayers.



 

Example 1:

3 underlayers along a polyline. Start- and endpoint are defined manually.
Select guide line: P1
From point: P2
To point: P3

Example 2:

3 underlayers along a polyline. Start- and endpoint correspond with the endpoints of 
the polyline.

Select guide line: P1
From point: <Ret>
To point: <Ret>

Example 3:

Sometimes it's necessary to insert e.g. 3 layers of underlayers, but after the first 
layer, you should continue with another element and come back to insert the 
remaining 2 layers.

In this case you can call up the underlayer option 2 times.

The first time you should define Total number of underlayers=3, Start layer=1 
and Actual number of underlayers=1. The second time you should define Total 
number of underlayers=3, Start layer=2 and Actual number of 
underlayers=2. 

Now 3 underlayers should be inserted on an edge. Start- and endpoint correspond 
with the endpoints of the edge. After the first layer, the underlayers of a dot have to 
be inserted before the two remaining layers can be inserted.

Definition of the first layer:
Select guide line: P1
From point: <Ret>
To point: <Ret>



Definition of the remaining two layers:
Select guide line: P1
From point: <Ret>
To point: <Ret>

 



How to work with modules

A module is a pattern of stitches, which can be recorded under a certain name and 
arranged along a polyline (running stitch). 

The modules are saved in the drawing and can be called up also in later editing 
sessions.

Attention: As the modules are saved in the drawing they will 
not be available in other drawings.

Modules can be inserted automatically along a polyline. After having selected the 
Module option from the previous menu the module menu is opened.

You can choose one of the following options...

Menu entry Description

Define new Define a new module and save it under a 
certain name.

list of modules A list of existing modules is displayed, from 
which you can choose the one you want to 
have arranged along the polyline. 

When you call up the module option for the 
first time from a certain design, no modules 
will be listed. Before you can work with a 
module you will have to define one first. 

Cancel Interrupt the module option and return to the 
previous menu.

How to define a module

Before you can arrange modules along a polyline you will have to define them. With 
the option Define new you can create new modules.

A module will always be defined on base of an existing polyline. First you have to 
choose this polyline, next you define the base point of the module. This point is 
normally a point on the polyline. Now you can continue designing the module. The 



last point of the module should be the point, where the next copy of the module 
should start. This point is normally also on the polyline. After having defined the last 
point, you can terminate the definition of stitches with Return. A menu opens, 
where you have to choose the Enter option to terminate the module definition. In 
this menu you can also choose Undo in case you want to go back one step. Finally 
you have to define a name for the module.

Example:

With the following dialog you can create a new module named Triang.

Command: TURNS
From point: point
To point: Total=0: <Ret>

>> Select option Module from the menu <<

>> Select option Define new from the menu <<

Select guide line: P1
Insertion point: P2
To point: P3
To point: P4
To point: P5
To point: P6
To point: <Ret>

>> Select option Enter from the menu <<

Module name: Triang

How to arrange a module along a polyline

Once a module is defined you can arrange it along a polyline.

To arrange a module choose a previously defined menu from the module menu and 
choose the polyline, along which you want to arrange the module. Next you can 
define, where the modules should start and where they should end. If you confirm 
the enquiries with Return, the endpoints of the polyline are taken over as start- and 
endpoint for the module distribution.

Example:

With the following dialog you can create arrange the previously defined module 
Triang.



Command: TURNS
From point: point
To point: Total=0: <Ret>

>> Select option Module from the menu <<

>> Choose module Trian from the menu <<

Select guide line: P1
From point: <Ret>
To point: <Ret>

 



MODIFY - How to modify punched sequences and 
functions 

Toolbar: Modify embroidery objects > Modify embroidery objects  

Menu:  Enlarge > Modify embroidery objects

Keyboard: MODIFY

This command allows you to modify machine functions or punched sequences, 
created with the  TURNS command or read in with the  INPUT command.

You can...

●     insert stitches

●     remove stitches

●     break apart punched sequences

●     insert machine functions

●     remove machine functions

●     edit machine functions

●     navigate in the punched design

After calling up the command you can select the object, which you want to change 
and perform the desired modification.

See also...

 How to navigate in the design

 How to modify a machine function

 How to modify punched sequences



How to navigate in the design

After having selected a punched sequence or a machine function, the selected object 
will be highlighted, a mark will be displayed at the selected position and a popup 
menu will be displayed. The upper options of the menu allow you to navigate in the 
design and are the same for functions, embroidery objects like Blattstitches, Edges 
etc. and punched sequences, created with the  TURNS command.

You can choose from the following navigation options...

Menu entry Description

Previous One back

Next One step further

Step Specify the step width. You can choose 
between Turns, Objects and Functions

With Previous you can go one step back, with Next you can go one step further. 
The mark will be moved to the new position and in case, that you step to another 
object, the new object will be highlighted.

Note: To step faster through the design you can also use the 
keys B to step to the Previous position and N to step to the 
Next position. 

With Step you can specify the step length for the the Previous and Next option. 
You can choose between...

●     Turns - you can step through the design turn by turn. The mark indicates the 
actual position.

●     Objects - you can step from embroidery object to embroidery object. An 
embroidery object can be a machine function, a punched sequence, created with 
the  TURNS command, or a high level object like Blattstitch, Edge, Geflect, 
etc.

●     Functions - you can step from machine function to machine function.

Note: Embroidery objects like Blattstitches and Edges are 
seen as compound objects and single stitches cannot be 
modified. Also in the Turns mode, the program will jump over 
the object.



How to modify a machine function

After having selected a machine function, the symbol will be highlighted and a popup 
menu will be displayed. In the upper bar of the menu you can find the number of 
turns and the name of the selected function.

You can choose one of the following options...

Menu entry Description

Previous One step further

Next One step back

Step Specify the step width. You can choose 
between Turns, Objects and Functions

Function value The value of the selected function is 
displayed and can be modified. 

Some functions have no values. In this case 
no menu entry is displayed. 

Connect Connect the function with an already 
punched sequence.

Delete Delete the selected function

Done Exit from the menu and select the next object 
to be modified.

Cancel Interrupt the command

See also...

 How to navigate in the design



How to modify punched sequences

After having selected a punched sequence, it will be highlighted, a mark will be 
displayed at the actual position and a popup menu will be displayed. In the upper 
bar of the menu you can find the number of turns at the marked point.

You can choose one of the following options...

Menu entry Description

Previous One step further

Next One step back

Step Specify the step width. You can choose 
between Turns, Objects and Functions

Stitches Switch the display of stitches On/Off.

Highlight 
previous

If Highlight previous=Off, only the actual 
embroidery object is highlighted.
If On, also all embroidery objects before the 
actual object are highlighted.

Pan center Move the actual position (position of the 
mark) to the center of the screen.

Zoom + Enlarge the display size by factor 1.5.

Zoom - Reduce the display size by factor 0.75.

Insert 
function

Insert a machine function at the position of 
the mark.

Break 
between 2 
points

All stitches between two points are removed 
and the punched sequence between the two 
points is opened.

Straighten 
between 2 
points

All stitches between two points are removed 
and the two points are connected with a 
stitch.

Insert point Insert stitches in a punched sequence.

Break till the 
end

Removes all points of a sequence from the 
actual position to the end of the element.

Connect Connects the end of the actual sequence with 
the start on another embroidery object. The 
endpoint is moved to the starting point of the 
selected object.

Delete Delete the selected sequence

Done Exit from the menu and select the next object 
to be modified.



Cancel Interrupt the command

See also...

 How to navigate in the design

How to insert a machine function
If you select this option a menu will be opened where you find a selection of 
machine functions, which can be inserted at the actual position. The selection of 
machine functions depends on the actual status of the machine and on the 
definitions, which you made on start of a punching session.

See also...

 How to insert machine functions

Shortcut keys
Several options are directly available by pressing a key on the keyboard. The 
following shortcut keys are available...

B - Previous

N - Next

I - Zoom +

O - Zoom -

P - Pan center

How to break a sequence between 2 points
With the option Break between 2 points all stitches between the mark and a 
defined point are removed and the punched sequence between the two points is 
opened.

After selecting this option you can pick the end point of the part, which has to be 
removed. The part between the mark and the defined point will be removed.

How to remove stitches
With the option Straighten between 2 points all stitches between the mark and a 
defined point are removed and the section is connected with a stitch.

After selecting this option you can pick the end point of the section, which has to be 
straightened. The stitches between the mark and the defined point will be removed 
and the two points will directly be connected.

How to insert stitches
With the option Insert point you can insert one ore more stitches in the actual 
sequence. First you have to select the stitch, where you want to insert an additional 
point, then you can define the position of the new point.

Example:



Insert two stitches in a punching sequence.

Select stitch: P1
Insertion point: P2
Select stitch: P3
Insertion point: P4
Select stitch: <Ret>

How to remove stitches from the actual position to the end of the 
sequence
With the option Break till end you can remove all stitches from the actual position 
to the end of the actual sequence.

This option is only available if the actual element is not yet connected with another 
element.

How to connect a sequence with another embroidery object
With the option Connect the end of the actual sequence can be connected with 
another embroidery object. The object can be an embroidery object like a Blattstitch, 
an Edge, a Step stitch etc., a machine function or another punched sequence. The 
endpoint of the actual sequence is moved to the starting point of the selected object.

This option is only available if the actual element is not yet connected with another 
element.



OUTPUT - How to export punching data

Toolbar: Write machine code 

Menu:  -

Keyboard: OUTPUT

With this command you can write the punched data to a machine readable file 
format. After calling up the command, the output menu will be opened where you 
can choose the desired format.

You can choose one of the following options...

Menu entry Description

SLC-Plauen The data are written in Saurer SLC-Plauen 
format. The file gets the file extension pls.

SLC-Saurer The data are written in Saurer SLC-Saurer 
format. The file gets the file extension sas.

SHC The data are written in Saurer SHC format. 
The file gets the file extension pat.

SLC-Plauen The data are written in Saurer SLC-Plauen 
format. The file gets the file extension pls.

Hiraoka DAT The data are written in Hiraoka DAT format. 
The file gets the file extension dat.

Lässer The data are written in Lässer format. The 
file gets the file extension mst.

Tajima The data are written in Tajima format. The 
file gets the file extension dst.

X Scale factor Scale factor, by which the design is stretched 
horizontally. 

Y Scale factor Scale factor, by which the design is stretched 
vertically.

Generate info-
files

If this option is ticked, the system creates the 
infofiles name.err (error messages), 
name.log (list of issued machine 
commands) and name.hex (list of issued 
machine commands in Hex).

Test functions 
only

This option allows you to test the design. The 
system will inform you about too short and 
too long stitches, more/less errors and 
machine function errors.

Done Write the data in the selected format.

Cancel Interrupt the command.



 

After having left the menu with the option Done the file dialog-box opens, where 
you can specify the file name and folder. If the option Generate infofiles is 
selected, the system creates also a file named name.err. This error file informs you 
about problem, which the system detected on export. If the system detects too long 
stitches, they are divided automatically.

When the stitch data are written, the system detects short stitches. After having 
written all data the systems informs you about short stitches with needle on and 
short stitches with needle off.

The values for the short stitch detection can be defined in the file DEFAULT.INI
amd_minsanon = 10    > minimal Saurer needle on stitch
amd_minplnon = 6     > minimal Saurer needle off stitch
amd_minsanoff = 50   > minimal Plauen needle on stitch
amd_minplnoff = 50   > minimal Plauen needle off stitch

How to detect punching errors
To test the your design for punching errors you can select the option Test 
functions only. In this case no data are written. The system just scans the whole 
design and checks it for errors.

The system checks the design for the following problems:

●     Too short stitches

●     Too long stitches

●     More/Less errors in case of SLC-Plauen format

●     Machine function errors

When the system detects a problem, an error message will be displayed e.g. Too 
long stitch at turn 62 element 10F4H!. After confirming with OK, the system 
jumps to the position, where the problem was detected and you can choose between 
the following options:

●     Continue if you want to continue testing

●     Edit if you want to correct the problem immediately

●     Cancel if you want to stop testing

Note: The minimum and maximum stitch length for needle on 
and needle off can be defined in the file DEFAULT.INI. This 
file is located in the program directory C:\Icad.



How to stretch the design
Sometimes it is necessary to stretch a design horizontally or vertically. With the 
option two options Scale factor you can specify a scale factor, by which the design 
will be stretched on export. The default value is 1. E.g. if you want to stretch the 
design vertically by 10% you have to choose the option Y Scale factor and enter a 
value of 1.1.

Note: The design will not be changed by this value! 

 



INPUT - How to import stitch data for editing

Toolbar: Read machine code 

Menu:  -

Keyboard: INPUT 

This command allows you to read files in machine code for editing. After calling up 
the command, you can choose the desired file format from a menu. Actually files of 
the type PLS (SLC-Plauen), SAS (SLC-Saurer), PAT (SHC). DAT (Hiraoka), MST 
(Lässer) and DST Tajima are supported.

You can choose one of the following options...

Menu entry Description

SLC-Plauen SLC-Plauen file with the extension PLS

SLC-Saurer SLC-Saurer file with the extension SAS

SHC SHC file with the extension PAT

Hiraoka DAT Hiraoka file with the extension DAT

Lässer Lässer file with the extension MST

Tajima Tajima file with the extension DST

Color change Define color change type

Function 
automatic

If this option is activated, all functions are 
filtered out from the design, which are 
inserted by ProLace automatically when stitch 
data are written. This are e.g. Speed, 
Blattstitch, Small Thread Guide,...

Cancel Interrupt the command

After having selected the file type, you can choose the desired file with the file dialog-
box and finally you must specify the point, where the start should be inserted.

Note: Importing a design from a low level format like SLC, 
SHC etc. can result in very long uninterrupted sequences. To 
prevent this effect the system can split such a sequence in 
smaller groups of stitches.
With the variable amd_maxnosti you can define after how 
many stitches the system creates a new group.
This variable can be defined in the file DEFAULT.INI. By 
default this variable is set to 1000.

STOP handling in case of Tajima format
If Function automatic is on, a stop switches automatically to the next needle.

If Function automatic is off and a stop is detected, you can choose from a menu 



in which ProLace function the stop should result.

You can choose one of the following options...

Menu entry Description

Stop Insert a STOP command

Borer Switch Borer On/Off

Change needle Change to another needle. If you choose this 
option you can select one of 12 needles.



NP - Needle programming

Toolbar: Needle pattern 

Menu:  -

Keyboard: NP

With this command you can program the needles for Lässer and new Saurer 
machines. Up to 100 stations can be defined.

After calling up the command for the first time, a dialog-box opens with the standard 
stations according the actual repeat. An X means Needle On a 0 means Needle Off. 
You can change the programming of a needle of a station by simply clicking onto the 
corresponding 0/X. When you leave the dialog-box the Needle Pattern file will be 
created. In case of Saurer SHC, the needle information is written to a file with the 
extension .npf, in case of Lässer, the information is written into the header of the 
.mst file on writing the stitch data.

Later, if you call up the command again, the corresponding Needle Pattern file will 
be read and displayed in the dialog-box. Now you can make the desired 
modifications. When you leave the dialog-box, the changes are written to the file.

Add station
Add a new station to the end of the list. 

Delete last
Delete the last station in the list.

Delete all



Delete all stations in the list.

Set NP default
Set the stations to their initial values.

Read NP file...
Via this button you can read an existing Needle Pattern file.



Description of machine functions

ProLace actually supports Saurer SHC, Saurer SLC, Hiraoka DAT, Lässer MST and 
Tajima DST formats. The SLC format is divided in SLC 46 Plauen and SLC 22 Saurer 
formats.

See also...

 The SLC 22 Saurer format

 The SLC 46 Plauen format

 The SHC Saurer format

 The Hiraoka DAT format

 The Lässer MST format

 The Tajima DST format



The SLC 22 Saurer format

The Code type SLC 22 covers all 22 channel Saurer card based machines.

General data
1 machine unit = 1/10mm

Value range in X and Y direction: -171 to +171

Standard functions
In the column Def. you can find the default values on startup of the program and in 
the column Range you can find the value range of the function. A rang with + 
behind the value means, that the value of the function can only be increased (e.g. 
TB: 1->2->3->4->1->2->...). A range with +/- behind can be increased and 
decreased within the given values.

SLC-
No Mnem. Def. Range Description

0, 1    no function

2, 3 NR Off On/Off Needle roller

4, 5 TB+ 1 1..4 + Thread break

6, 7 STU Off On/Off Stupfel

8, 9 BSTI Off On/Off Blattstitch

10, 11 SC On On/Off Speed control

12, 13 STOP   Stop

14, 15 STG+ 1 1..6 + Thread guide

16 BS- 6 1..12 +/- Borer size minus

17 BS+ 6 1..12 +/- Borer size plus

18, 19 CRD Off On/Off Cord laying

20, 21 CLU Off On/Off Clutch

22 PS- 6 1..12 +/- Production speed 
minus

23 PS+ 6 1..12 +/- Production speed 
plus

28, 29 F Off On/Off Feston

30, 31 NOP   No  operation

128 COM   Comment

129 END   Block end



130 REP   Repeat start

131 WUP    

255 CODE   Code type

Color change FRW old (STANDARD)
Machine type: Saurer schiffli embroidery machine

Color change system: Pentamat old, FRW Zangs

SLC-
No Mnem. Original Description

6, 7 SS STU Pentamat

18, 19 FRW- CRD FRW station -

28, 29 FRW+ F FRW station +



The SLC 46 Plauen format

The Code type SLC 46 covers all 46 channel Plauen card based machines.

General data
1 machine unit = 1/6mm

Value range in X and Y direction: -99 to +99

Standard functions
In the column Def. you can find the default values on startup of the program and in 
the column Range you can find the value range of the function.

SLC-
No Mnem. Def. Range m/l Description

2 NR- x  l Needle roller off

3 NR+   m Needle roller on

6 STU+   l Stupfel on

7 STU- x  m Stupfel off

8 BST+   l Blattstitch on

9 BST-
,BH

x  m Blattstitch off, Borer

10 SLOW x  l Slow on

11 FAST   m Slow off

12 STOP   l Stop

13 STOP   m Stop

14 STG+   l Thread guide plus

15 STG- x  m Thread guide minus

16 BS- 7 1..13 +/- l Borer size minus

17 BS+ 7 1..13 +/- m Borer size plus

18 CRD+   l Cord laying on

19 CRD- x  m Cord laying off

255 CODE    Code type

Color change FRW old (STANDARD)
Machine type: Zangs schiffli embroidery machine

Color change system: FRW Zangs



SLC-
No Mnem. Original m/l Description

6 FRW- STU+ l FRW station -

7 FRW+ STU- m FRW station +

19 CS- CRD- m Switch axis



The SHC Saurer format

The Code type SHC covers the new Saurer machines like Epoca, Unica.

General data
1 machine unit = 1/10mm

Vector functions
The following table lists all SHC vector functions. 

SHC-
No Mnemonic Description

0 MOV Move withour thread

1 STI Stitch

2 BOR Bore stitch

3 STU Stupfel

4 BSTI Blattstitch

5 QSTI Quilt stitch

6 SSTI Single hole stitch

7 DSTI Double hole stitch

8 SUSP Suspension stitch

 
In the punching mode you can only Swith On/Off the Needle and the Borer. The real 
functions MOV, STI, BOR, BSTI, QSTI, SSTI and DSTI will be specified by the 
system when you write the machine code with the command OUTPUT .

Parameter functions
In the column Def. you can find the default values on startup of the program and in 
the column Range you can find the value range of the function.

SLC-
No Mnem. Def. Range Description

128 COM  0..255 Comment

129 END   End of block

130 REP 1 0..65535 Repetition

131 STOP 0 0..65535 Machine stop

132 CALL 1 1..410E9 Design call

133 DES 1 1..410E9 Design number



134 ARR 1 1..410E9 Arrangement 
number

246 PRGM  0..255 Function number

247 TH  0..255 Thread length

248 PS 10000 0..10000 Production speed

249 BS  1..13 Borer size

253 UNIT   Vector unit

254 NP   Needle pattern

255 CODE   Code type

Standard settings for the Needle patterns
If no needle patterns are programmed, the following standard needle pattern 
settings are used by the system:

 1 2 3 4 5 6 7 8

All off 0.1 - - - - - - -

4/4 1.1 - - - - - - -

8/4 2.1 3.2 - - - - - -

12/4 4.1 5.2 6.3 - - - - -

16/4 7.1 8.2 9.3 10.4 - - - -

20/4 11.1 12.2 13.3 14.4 15.5 - - -

24/4 16.1 17.2 18.3 19.4 20.5 21.6 - -

28/4 22.1 23.2 24.3 25.4 26.5 27.6 28.7 -

32/4 29.1 30.2 31.3 32.4 33.5 34.6 35.7 36.8

Example:

To work with needle 2 in the 20/4 repeat, you can use the function NP 12.2.

Change needle and Change repeat
If the needle pattern is set to default you have instead of the command NP the 
commands Change needle and Change repeat in the the function menu. When 
you use one of theese command, the system translates them automatically to the 
corresponding needle pattern command NP.

Example:

If the actual repeat is 16/4 and you change to needle 3 the system generates the 
command NP 9.3.



NP command
If you defined your own needle patterns or if you made changes to the standard 
needle patterns the NP commands appears in the the function menu.

To insert a NP function click on the option NP. Now the system shows you the actual 
value in the status line. Now you can enter a new value.

Example:

To change from repeat 12/4, needle 1 to 12/4 needle 2 enter the following value:
NP<4.1>: 5.2<Ret>

Instead of entering a new value you can also right click to open the window with the 
available stations and choose the desired station.



The Hiraoka DAT format

The Hiraoka's computerized embroidery machine decodes and executes the data 
stored in this format. The DAT file format is used for standard embroidery machines 
without the automatic repeat switching mechanism. It has the extension DAT.

General data
1 machine unit = 1/6mm

Value range in X and Y direction: -99 to +99

Standard functions
In the column Def. you can find the default values on startup of the program and in 
the column Range you can find the value range of the function.

F-No Mnem. Def. Range Description

00 NOP   No operation

01 BSTI off  Sperrzeug

02 NR off  Needle

03 BS 7 1..13 +/- Borer size

04 STOP   Stop

05 SLOW on  Slow

06    Not used

07 CRD off  Cord laying

08 NR+SLOW   Needle + Slow

09 BSTI+BS   Sperrzeug + Borer 
size

10 NR+BS   Needle + Borer size

11 SLOW+BS   Slow + Borer size

12    Not used

13 CRD+BS   Cord laying + Borer 
size

14 NR+SLOW+BS   Needle + Slow + 
Borer size

15    Pause



The Lässer MST format

The Lässer format describes the functions for all computerized Lässer machines. The 
file extension of Lässer files is MST.

General data
1 machine unit = 1/10mm

Value range in X and Y direction: -171 to +171

Standard functions
In the column Def. you can find the default values on startup of the program and in 
the column Range you can find the value range of the function.

Mnem. Def. Range Description

NR Off On/Off Needle roller

BSTI Off On/Off Blattstitch

BOR Off On/Off Borer

FAST Off On/Off Fast speed

LTG Off On/Off Large thread guide

CRD Off On/Off Cord laying

CRZ Off On/Off Cord Zig Zag*

BS 6 1..13 Borer size regulation

LTGR 6 1..13 Large thread guide 
regulation

STG 1 1..4 Small thread guide 
regulation

TB 1 1..3 Thread break

CRDA 0 0..90 Cord angle

HSR 6 1..9 Head regulation*

PAI 0 0..7 Paillette regulation

NP 1 1..99 Needle program*

STOP   Stop

STOPT   Stop + text*

* not yet supported



The Tajima DST format

Most Multihead embroidery machines can decode and execute the data stored in this 
format. The file extension of Tajima files is DST.

General data
1 machine unit = 0.1mm

Value range in X and Y direction: -121 to +121

Borer displacement: 120mm

Standard functions
In the column Def. you can find the default values on startup of the program.

F-No Mnem. Def. Description

03 STI off Normal stitch

83 MOV on Jump stitch

C3 STOP  Stop / Needle change / Borer 
on/off

F3 STOP  End of design

43 PAI  Changeover (Paillette)
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